Game Building for Learning and Teaching Process
By Using Microsoft Excel Program

¥ I
-4 e «fZ.,.a”" \ ‘“P,Vlys-‘.’é&f:-’;i;.}
X

Ew .« Game Building by Using Microsoft Excel Program

Generally, Microsoft Excel program is mostly used for calculation,
salary preparation, accumulation of student score, data base management
and charges.

This book uses Microsoft Excel program in building up games for
the student to practice their knowledge in various subjects such as
Mathematics, English, Scientific, Thai and Art. The student needs to apply
the capacity of Microsoft Excel Program and their knowledge to design and
create their assignment, game to develop their skill knowledge.

The details and steps in game building will be explained o the
student to follow by pictures. The student can follow immediately and if
the student would like to know the details of some content of the program,
they can study from the assigned document on the usage of Microsoft
Excel Program in particular the assigned book on “"Microsoft Excel base-
game Building Techniques”. This book provides the summary of steps and
methods for game building by using Microsoft Excel Program.



Ew # Basic Agreement in Game Building

e Assignment presentation on the monitor
1. The work building in this document is supported by Microsoft
Office Version 2003.
2. The resolution monitor should be at 1024 x 768 pixels.
3. It can be adjusted by click
4

. Select '-' Conkral Panel
5. Select f_%“
Display
6. From Display Properties, select Settings
7. Define the Screen resolution to be at 1024 by 768 pixels as

appears in the picture

Screen rezolution
Less D ore

1024 by 763 pirels

8. Click | &pply
 Click

\O

Note :Most of the monitors use 1024x 768 pixels, but if the pixels are
less or more, the data on the monitor may not be completed or it
may be too large, forcing us to use the scroll bar to see the data
which do not show in the monitor.



g Symbol and Calculation in Microsoft Excel

/# Calculation symbols

Calculation symbols of Microsoft Excel Program work in the same way
as the mathematics symbols, but there are some symbols of which their
forms are different, for example multiple, minus, divide and square.

Calculation Symbols Comparison Symbols
+ s plus = s equal
is minus > s more
* is multiple < s less
/ is divide >= s more or equal
T square <= s less or equal
% s percentage <> is unequal

Symbols to link messages
&  Linking the defined cells for example =A1&B1

Reference Symbols
: (Colon) using for identifying the period of data, for example

A:A means the whole of column A
A2:A8 means from Cell A2 to A8
1:3 means the whole row both row 1 and row3

A:IV means the whole working table



e Sequence of Calculation

The calculation of data in each order set: if many symbols are used
in the same order, Microsoft Excel Program will calculate in consequently as
following;

Sequence Symbols Meanings
1 () bracket
2 ~ square
3 * and / multiple and divide
4 +and - plus and minus
5 & linking messages
6 = < > <= >= <> | comparison signs

Note : The symbols that are in the same sequence, calculation will start
from left to right, if you would like to calculate which part first,
please put the bracket () in that part.

Example: Calculation according to the sequence of symbols

=2+5%6 if calculated by mathematics, the result is 42
(2 plus B, the result is 7, then multiple with 6, the result is 42).

=2+5%6 if calculated by Microsoft Excel Program, the result is 32
(5 multiple by 6, the result is 30, then 2 plus 30, the result is 32).

From the example question, if you would like fo have the result to be 42,
then you have to change question to be =(2+5)*6.



‘ g © Start using Microsoft / Excel Program

1. Click
. Select the program @ Micrasoft Ofice Excel 2003
3. Microsoft Excel Program Work Sheet Window will be displayed,
use 100% working view.
4. Arial Font will be displayed (To prevent the change of Font when
open the program at other computer.)
Example: Window of Microsoft Excel Program when it starts.
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1.

Methods to Name a Game

Type the game name into the defined cell, then adjust Font to suit
the space and color it as you like.

A B C D E F € H I J K

1
2

Number Finding Puzzle Game

. Design the Font in the game name by using WordArt <l from

Drawing Toolbars.

The Col _Balloons

. Use Adobe Photoshop Program to design the Font in the name

game, then record the game name using .gif or .jpg families.
Insert picture into the work sheet.

Cursed Angel Game

Format the Size of Font of the game name to be in the proper
position.



‘ Ey . Decoration of the Won‘i‘(’ing Table

#” Format the Font
Format the Font by using Font from Formatting Toolbar

| @@ ooy 4 0 0 EE

¥
i

|.-5.rial -0 « B I U| =

/# Data Alignment

j—— ===

1. Click menu Format. [mbe | G | uFat o Bouder | Paiens. | Proacion]
2. Select Cells. Tt e creese
3. Window will appear as S T A

in the picture. o <] t e
4. Click Alignment B Lt
5. Align the data in both horizontal | 2% 5T egees

and vertical Directions. v
6. Adjust the degree of data as et

needed.
7. Click OK

Note : If you would like to align the data to be more than one line.

Text control

Click Wrap text. oo

Click OK.

1. Please obsere the red gap. If your answer is
right, the colour of each gap will change into the
same colour as it is in the fixed gap.



/ Determining the Color of the Table

1. Select the space. No Fil

2. Click the pointer after the sign : : : : : : : :
Fill Color % - on the toolbars. - EEEE

3. The program will present colors to choose. g n

4. Click to choose the required color.
e Determining the Color of Font
1. Select the cell that you would like to color the Fonft.
2. Click the pointer after the sign Font Color A - on the Toolbar.
3. Click the color of Font as you like.

/# Insertion of Symbols
1. Select the cell that you would like to have symbols.
2. Click menu Insert.
3. Click Symbols.
4. Select the Font which has symbols such as Wingdings.
5. Click Insert.

/ Determining Border of the Table
1. Select the cell that you would like to have border.
2. Click the icon & on the Toolbar to select the border.

Note : If you would like to determine more details, right click in the cell
and select Format Cells.



e Changing 6Gridline

1. Click menu Tools.
2.. Click Options.

3. Select View from Toolbar.

4. Select the gridlines color.  aridines color: |

5. Click OK.

/ Cancelling 6Gridline

1. Click menu Tools.

2. Click Options.

3. Select View.

4. Click the symbol [¥|cridines out.
5. Click OK.

# To Use the Tool Format Painter

1. Click to select the cell which has been formatted.
2. Click Format Painter < on the tool bar.

3. Move your mouse to click on the position that you would like to

Note :

format as the example cell.

4. The format of that cell will change according to the selected

example cell.

If you would like to use the format in various places at the same

time , you can double click at Format Painter. <2* This will result in
placing the format continually until you click the icon again.



# Tnsertion of Picture into the Table

1

2
3.
4

. Select Picture. e [@oem - .
Select From File. g £y |
Dacumen its - c;‘ { 9‘/ . .
. Select the folder @ | A f"&? A !
. . Desktop 47c52167c4fch.ipg 10172383.jpg 0972270034df4.ipg
which has pictures.
Click to select the |,/ fa
required picture. o7 »
C“Ck Inser..'.. MVC’T‘?U‘E’ 1111557449571,9pg aaabmp  anima 12.png }
| -

Click menu Insert. ..

My Network .
Places Files of type: | Al pictures (*.emf;* wmfi=.jpg; * jpeg; *.3ff;*.jpe; * png; » Cancel

Note: If youwould like o have Animation picture, select the pictures with
.gif family and try it first before, Saved it on the webpage.

/" To Save the Worksheet on Webpage

1.

2.
3.
4.

5.

Select the worksheet that you would like to present on the
internet.

Click menu File.

Select Save for web.

Determine the file name such as Solution to the Ladder
Puzzle.

Click Save.

Note: To save the worksheet on webpage, it will show the output only. It is
suitable for presenting the content, or game solution as it cannot
retype nor correct the data in the Cell.
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/# To use the pictures as the background of the worksheet.
1. Click Format.
2. Click Sheet.
3. Select Background.
4. Select the pictures that you would like to put on, click Insert.
5. The selected pictures will appear as the background of the
worksheet.

B Fe ot vew Imert Fomat
DEHRS SRIVE %5 - 8z
U= = o

Toos Data Window Hep . x

-of

/" To Cancel the Background Pictures
1. Click menu Format.
2. Click Sheet.
3. Select Delete Background.

1"



# To design WordArt. e ——

1. Click Insert WordArt <l _— 'war“‘"il*""’“"“‘""“" Wortarl] WY

on Drawing Toolbar. Wi WordAn Wt J‘m: w
2. A window with WordArt will - o P T

come up as in the picture. T H'.H 7
3. Click to select the required format, | ™™ % o ]t
4. Click OK . et [ B e §
5. Type the wordings in the set frame. L=
6. Click OK.

/# To Use AutoShapes
1. Click AutoShapes on the Toolbars on drawing.

Draw~ |g |AutoShapes~ \ W O E 4 S @ S-F-A-==5 B @8

2. Select the required shape.

3. Press the mouse and hold it for a while to draw the shape.
4. Right click in the shape and select Add Text.

5. Type the selected wordings in the shape.

Example: To Use AutoShapes.

[0)

U Welcome to My Game

12



/# TInsertion of Pictures into the Autoshape
Click the AutoShapes which you have built.
Click at Fill Color {3 - and select Fill Effects.

1.

ok wn

Select Picture tab to select picture.
Select the required picture.
Click OK.

/" To Rename the Sheet

1.

2.
3.

4.

Click menu Format.
Select Sheet.

Click Rename.

Type the required name.

# To change the Color of the sheet name plate

1.
2
3.
4

5.

Click menu Format

. Select Sheet.

Click Tab Color.

. Click to select the required color from

the table.
Click OK.

13
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# To Add Sheet
1. Click menu Insert.
2. Select the sheet.
3. Sheet will show up.

# To Delete Sheet
1. Click menu Edit.
2. Select Delete Sheet.
3. If that sheet has data on it, it will pop up in your window, you
have to confirm Delete.

! "_\, Data may existin the sheet(s) selected for deletion. To permanently delete the data, press Delete,

[ Delete [ Cancel ]

4. Click Delete, the sheet will be deleted immediately.

# To change the position of the Sheet
1. Click to draw the bar of the required sheet such as Sheet 3
moves left or right as required.
2. Notice position pointer which will move fo and flow, when it
comes to the required position, you can release the mouse.

14



# To adjust the width of the column
1. Click menu Format.
2. Select Column.
the window will appear Lok ][ cancel
as in the picture.
3. Click Width,and identify the required width.
4. Click OK.

Column width: 3.43

# To adjust the height of the row

1. Click menu Format.

2 SelectRow. Row height: 13,75
the window will appear | ok || cancl
as in the picture.

3. Click Height, and identify the required height.

4. Click OK.

# To insert row and column
1. Click the name of the row or column which needed to insert.
2. Click menu Insert.
3. Select Row or Column.

# To delete row and column
1. Click the name of the row or column which needed to be
deleted.
2. Click menu Edit
3. Select Delete.
15



# To Cancel the Details of the Working Timetable
1. Click menu Tools.
2. Select Options.
3. Click View as shown in the picture.

- ey — |
Color | International | Save | Error Checking | Speling | Security |
View Calculation | Edit | General | Tramsion | Customlists | Chart |
Show

Startup TaskFane [ | Formula bar |:|§tab.|sl:|ar Windows in Taskbar
Comments

() None @ Commentindicator only () Comment & indicator
Ohjects

@ Show all () Show placeholders () Hide all

Window options

[] Page breaks [] Row & column headers Horizontal scroll bar
[] Formulas Qutline symbaols Vertical scroll bar
[ Gridlines Zero values [] sheet tabs

Gridlines colar: Automatic -

[ Ok ] [ Cancel ]

4. Click the symbol in the provided space ouft. for example

[ Formula bar - [7] Status bar [l Gridines [T Row & column headers | Sheet tabs

5. Click OK.

16



g © To Add Text to Cell

Sometimes it may be necessary to put in the explanation or
comments in one of the Cells, which normally will be hidden until the mouse
points out at that Cell or there is an order to show it all the time.

/" To Insert Comments

1. Click right on the cell that you
would like to put the explanation.

2. Select Insert Comment.

3. Type the explanation in the
appeared space.

4. Click in the empty space
in the table.

5. There is a symbol of red friangle

showing that the Cell has the explanation.

6. When the mouse is put on the Cell,
it will show the explanation.

# To correct and Delete Comments

If correction, decoration, and delete is
needed, click right in the cell and select the
required menu.

TO decorate, click at the border of comment
which will enable you to brief up or enlarge and
change the background color or the font color.

17
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Ey Conditional Cell Formatting

Generally, Cell decoration or Cell Formatting depends upon the
player. If the player decides o have the background color to be yellow, the
program will show yellow color. This kind of cell decoration is considered to
be unconditional, but if we would like it to show color that is based upon the
data value in the Cell which show the score for example. if the score is low
it will be in red color, and if the score is average, the Cell will be in orange.
And if the score is good or excellent, the Cell will be green. This kind of
conditional Cell formatting needs to use comparison with the following methods;

/# Conditional Cell Format
1. Click the Cell that you would like to have conditional
formatting.
2. Click background color of the Cell for example, blue
3. Clickmenu Format.
4. Select Conditional Formatting.
5. When the window is appeared, you can set up 1 condition.

e | —e—

Condition 1
Cell ValueIs |  egualto - | |50
Preview of format to use Mo Format Set
when condition is true: = =

Add>> | | Delete.. | | ok || cancel |

18



6. Select the data that will be used for comparison.

CelValueIs

7. Select the Cells for comparison.

equal to -

8. Determine the value for comparison.
Z
9. Click to select

10. Determine the required format for example

* Font * Border * Design( Color of the Cell background)
11. Click OK

12. If you would like to set up the second condition

Click

Then repeat steps 6-11 again.

13. When you have no further condition, click

/# To Cancel the Conditional Cell Formatting
1. Click the Cell that you would like to
cancel conditional formatting.

2. Click menu Format.
3. Select Conditional Formatting. [ Delete Conditional Format =X
4' CIICk Select the condition(s) to delete:
5. Select the condition that you would Comditan i
like to delete. Condition 2
6. Click Condition 3
Ok ] [ Cancel

19



Ew ++  Formulas and Functions for Game Building

4 Formulas to calculate the score

Function IF is used for calculating the value with testing condition, and

has 2 choices which are True condition and false condition. Example

=IF(64=8,1,0)
Means that if the value of Cell G4 equals to 8, you will get 1 point but if it
does not equal o 8, you will get O.

=IF(64="R",5,0)
Means that if Cell 64 has R, you will get 5 points, if not, you will get O.

=IF(64="Chiangmai",1,0)
Means that if Cell 64 has the word Chiangmai, you will get 1 point, if not,
you will get O.

=IF(64="Orange",1,IF(64=" Oranges",k1,0))
Means that if 64 has the word Orange or Oranges , you will get 1 point,
if not, you will get 0.

=IF(64="Orange",1,IF(64=" Oranges",k5,0))
Means that if Cell 64 has word Orange, you will get 1 point, if Cell G4
has the word Oranges you will get 5 scores. If it is neither words, you will
get O.

Note : You canuse IF several times in case you have many conditions, but you
need o have the symbol of ), close bracket. The number of symbol
should be the same number of the symbol (, open bracket.

20



/# Formulas to Calculate the Total Score
Function SUM is used for calculating the total score of the set up data.
Example
=SUM(D5:H5) means the total score from cell D5 cell H5
=SUM(D5,D10,D15,D20) means the total score of cells
D5,D10,D15,D20
=D5+D10+D15+D20 means the total score only for cells
D5,D010,D15,D20
=Sheet2|E4+Sheet3|E4+Sheet4lE4 means the total score of
Sheet2 cellE4 ,Sheet3 cell E4 and Sheet4 cell E4

/# Formulas to Enhance Drive and Encouragement
Function IF is used for calculating the value with condition in testing.
Example
=IF(D5=6,"Best of the world", IF(D5=5,"Excellent" IF(D5=4,"Great",
IF(D5=3,"Well Done", IF(D5=2,"Keep trying",IF(D5=1,"Life has just begun",
IF(D5=0,"Try harder"," "))))))
The meaning is if Cell D5 gets 6 points, the following words will show
up Best of the world
if CellD5 gets 5 points, the following words will show up Excellent.
if CellD5 gets 4 points, the following words will show up Great.
if CellD5 gets 3 points, the following words will show up Well Done.
if CellD5 gets 2 points, the following words will show up Keep trying.
if CellD5 gets 1 point,the following words will show up Life has
Jjust begun.
if Cell D5 gets O point the following words will show up Try harder
if CellD5 has no, the Cell will be left blank.

21



/# Formulas to find Percentage
To count the number of play time or to reply to the question of how
much is your percentage, means that to bring the fotal score and divide it
by all the answers, for example
-H14/6 is the total score which is in Cell H14 will be divided by all

the answers. [Fomatcats e )

Then, format the number —
1. Click right in the = oo
required Cell. omdre 2
2. Select Format Cell. percen
3. Click Number-. e
4. Select Percentage e
as shown in the picture. gt ity bl o 0 el st it
5. Click OK.

»Currently you get

/" To Hide the Data in the Cell
After finishing the game building, try enter and delete the data into
Cell, test the formula to ensure that calculation formula and references are
correct. Then, hide the data or the formula in the Cell by selecting one of
the following methods that you think it fits well;
1. Change the color of the score Font to be in the same color as
the Cell background.
2. Change the Font size in the Cell that has points to size 1.
3. Use menu for hiding row or column which has points.

22



- Building Hyperlink /7

e Building hyperlink in the sheet
1. Select Cell picture or wording which will be used as linking point.
o

g
i S '@ Solution Back

] i 8]

2. Click ¥ to insert Hyperlink
3. A window, which is shown hereunder will show up

Insert Hyperlink (A
Link to: Text to display: Play
Type the cell reference:
Existing File or | |aq
Web Page
Or select a plage in this document:
4 Cell Reference
=T [Game baloon’ |
T — Solution balloon
Defined Mames
Create New
Daocument

E-mail Address

[ OK ][ Cancel ]

4. Click to select Place in this document, and select the
required Cell reference.
5. Click OK.

23



e Building Link outside the sheet

1. Select Cell picture or wording to be used as linking point.

www.krujanjira.com www.google.com

2. Click @ to insert Hyperlink.
3. The following window, as shown hereunder, will show up.

Link to: Text to display: |www.google.com .
8] Look in: g My Computer -
| | & Fonts | Bookmark...
o | 4@ Administrative Tools b
Felder g8 My Sharing Folders
Plaiein This IS My Documents .
Document Browzed ||J) Shared Documents
Page= E?m Master {C:)
n s DATA (D:) E
Choate New T &b DVD-RAM Drive (I:)
Document Files “»* Removable Disk (F:)
= Removable Disk (G:) b
Address: http:/fwwew. google. com -
E-mail Address
ok || Cancel
4. Select Existing file or Webpage.

o

Identify the required address http://www.google.com
6. Click OK.

24



&+ To Unlock Cell Which is Used as AnsweringCell

When the game is completely built, it is necessary to lock Cell to
prevent data correction. Blank Cells will be provided so that the player can
correct and adjust their answers all the time. Those Cells will be unlocked
before protection measures are applied.

/" To unlock Cell to be used as answering Cell
1. Click to select Cell that are enable to be corrected.
2. Click menu Format
3. Select Cells
4. Click to select

Protection Tab —
5. Click in the locked Cell i ———el

| Number | Alignment | Font | Border | Patterns

to become blank,
as shown in the picture

..................

V| Locked
Hidden

. Locking cells or hiding formulas has no effect unless the
H||:||:|E|‘| worksheet is protected. To protect the worksheet, choose
) Protection from the Tools menu, and then choose Protect

Click OK. Sheet. A passward is optional.

7. Protect the sheet by click
at Menu Tools.

8. Select Protection.

9. Click Protect Sheet..

10.Click OK. [ ][ conce

o

Note : The data in the selected Cells can be corrected.

25



‘ Ey Sheet Protection by U&?ng Password

Sheet protection can be done by either using password or not.
If it is protected by not unlocking any Cells, it will protect the whole sheet,
data correction and edition can not be made at all.

/" To Protect Sheet R ——
L. Click menu Tools. -
2. Select Protection.
3. Click Protect Sheet. Al ol csersof ths merkcheet o
4. A window to set up Password will 3
show 0
5. Set up Password, then click OK. D et colums L]
6. Confirm Password again, click OK. %é:g“?m'“ |
Note : To set up Password, assignment (o ][ cancel |

owher needs to remember it, otherwise,
you cannot edit your worksheet again.

# To Cancel Sheet Protection
1. Click menu Tools.
2. Select Protection.
3. Click Unprotect Sheet.
4. A window to put in Password
will show up, click OK.

Password:

26



2. Additional Game Pages/’

To build up additional game pages is aimed to make the game
more complete, mostly, the additional game pages comprises index page,
game page, solution page, organizer page, and reference page.

0 The first page / index / menu is for greeting or welcoming
the player which may comprise the game name, or playing rules.

Game page, is for the player to find the solution by click to
select the solution or others.

0 Solution page is for the player to check the right solution.

Organizer page is for infroducing the organizer such as
picture, name and family name registration number, E-Mail address or game
building advisors.

Reference page is for providing the background of the game,
its content, pictures and related websites.

< f¥avia
@ M IAL K UTHATR S —x
@ wmangii. i 14 ) i
@ AL YA @
@ AT 19 ﬂ

-~ - z VS &
Q@ maTMEN. T g 8 ; e dons. il 3 554
@ manwlE, dTkEa § i z e

1 P 2
i | we dnsfug ymBas w. 5/4
2 g

' i 15

Example of Menu Page and Organizer Page
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[ﬂ To Save the Data '

1. Click menu File, click Save As... (or click [d)
2. Click to select the drive that you would like to save the data

suchas C: D: orE:
3. Double click the required folder such as 3 MyGame

4. Name the file such as Colorful Balloons, then

click OK.

Save in: | MyGame - @ B 'Q ; Tools =
2 @j 1Finding Number.xls
! |%l_..ijZE:DIrc::urfl.lI Balloans. xls
My Recent | |E]3Ladder Puzzle Computer. xls
Hiperments @ﬂhai Proverbs.xls
= @ﬂ SHow Many Game.xls
@ ] eFunny Sport. s
Desktop
My Documents
[~ !
My Computer
(d File name: Colourful Balloons| - Save
My Metwork =
Places Save as type! | Microsoft Office Excel Warkbook (=.30s) - ~ Cancel ||

Note : If you save again under the same name, click [d

28




‘ & To Open thggﬁile '

A

1. Click menu File, select Open... (or click 5 )
2. Click to select drive to save the datasuchas C: D: E: orA:
3. Double click to select the required folder
such as [ MyGame
4. Click to select the File name such as Colorful Balloons,

click Open.

Lookin: |33 MyGame - |

. I% 1Finding Mumber . xds

My Recent @ﬂledder Puzzle Computer. xls
Hectmerits @ﬂhai Proverbs. xls

= @ SHow Many Game,xls
@ EL;E]E'Funny Sport. xls

Desktop

My Documents

T

My Computer

g File name: - Open =

My Netwark ;
Places Files of type: | All Microsoft Office Excel Files (=.x0%; =xls; =lt; = htm; * = Cancel §
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Number Finding Puzzle Game

l%] Eile Edit W¥ew Insert Format Tools Data Window Help T ~ -8 X

DEHRIS SR 'ffjél & @

Arial -1z - |B|r U

[

e Solution

Rules in finding solution b

1. Let's calculate to find the right number to fill in
the red block in vertical and horizontal directions

The answers in both will be equal

2. Please observe the red gap. If your answer is

right, the colour of each gap will change into the

same colour as it is in the fixed gap.

Scores

0

Game Page for the player.
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Solution to the Number Finding Puzzle Game

I%] Eile Edit W¥ew Insert Format Tools Data

Window  Help
DEHRS SRAVE $ER- & = -4 R ap e - @

Arial -2 -[[B]lr 1w

|y oy WS E

oA % %8259

v

.. Play Game

Rules in finding solution b

1. Let's calculate to find the right number to fill in
the red block in vertical and horizontal directions
The answers in both will be equal

2. Please observe the red gap. If your answer is
right, the colour of each gap will change into the
same colour as it is in the fixed gap.

Scores

6

4 4 » W[y PRyGameNumber ' SolutionNumber { Detzilumber /
Ready

UM

-
|

4|

The outlook of the Solution Page when the answer is correct.
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Number Finding Puzzle Game

'%] File Edit Wew Insert Format Tools Data Window Help a8 X
DEHRS SR VE | %GB B F-4LE I -@k
Aial -2 -|[B|zZ E | B 2EH e
A K L M N ] P =
—_—
1 | B
w— Play Game
2
3
*
Rules in finding solution
4
B 1. Let's calculate to find the right number to fill in
the red block in vertical and horizontal directions.
5 The answers in both will be equal
2. Please observe the red gap. If your answer is
right, the colour of each gap will change into the
6 same colour as it is in the fixed gap. ||
7
Scores
8
9 6
10
"
M 4 » W[ PlayGameNumber { SolutionMumber Y DetailNumber / < * | |
Ready MUM

GameBuild

The outlook of the Game which the details have not been deleted yet.
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9]

D Number Finding Puzzle Game

# Game Building Procedures and Methods

1. Build up the work in Book1 by starting from Sheetl
Adjust the width of ColumnA to Column Pto 8.00 (61pixels)
Adjust the height of Row1 to Row 11 to 39.00 (52 pixels)

3.  Merge Cells B1:J2, this space will be used for placing the name of
game "Number Finding Puzzle Game”. Adjust the position of the
name of game properly.

4. Type the number and mathematical symbols into the Cells, as shown
in the picture by starting typing number 2 in Cell C4.

A B € [ © [ & [ F | & [ 8 [ T [ 3 T %

‘ Nunbes inding Buzzle

3

4 2 |+ | 5|+ = | 15
+ + + +

5

G + +] 2| =12

: + + + +

+ | 6 + =
8
. 15| + + (13| = |40

Note : To type mathematical symbols in the cell, after typing, press
Enter only.
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10.

Format the font in cell C4:I10 to Size 22, and Bold.

Click menu Format >> Cell s>> Alignment , the font should be in the
Center both in vertical and horizontal directions, click OK.

Change the cell color as defined as following;

CellC4:I4 to Green. CellC5:I5 to Lime.
CellC6:I6 to Light green. Cell C7:I7 to Light turquoise.
Cell C8:I8 to Sky blue. Cell €9:I9 to Light blue.

Cell €C10:TI10 to Blue.

CelsD5 ,F5,H5, D7, F7, H7 , D9, F9 and H9 +to black.
Select the space of C€4:I10, click menu Format >>Cells>>Border,
select type of line, White, click Outline and Inside, click OK.

Select the space of cell B3:J3 ,B4:B10,B11:J11 and J4:J10,
change the Cell color to Black.

Change the color of the following Cells G4 , C6 , E6 , C8 , 68 , I8
and E10 to Red.

Click cell 64, select menu Format>> Conditional Formatting...,

when the Conditional Formatting window appears, set up as according
to the picture as shown.

EENEMNEN v | |equal to - |8 :

It means that if the Cell value is equal to 8, the condition is true,

cick

In the window Format Cells, click Patterns and select Green color,
then click OK.
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11.

The outcome will be displayed as in the picture, click OK.

Condition 1
Cell valueIs | egual to | |8

Preview of format to use
when condition is true:

| Add>> || Delete.. | | ok || cancal |

Try typing the number in cell 64, you will see that if the cell value
is not equal to 8, the Cell color is still Red. If the cell value equal
to 8, the Cell color will change to Green.

Format the cells according to the condition to the red cells;
C6,E6,C8,68,1I8 and E10 by using the same procedures as item 10.
The cell value in C6 is equal to 9, the required color when the value
is correct is Light green.

The Cell value in E6 is equal to 1,the required color when the value is
correct is Light green.

The Cell value in C 8 is equal to 4, the required color when the value
is correct is Blue sky.

The Cell value in 68 is equal to 3, the required color when the value
is correct is Blue sky.

The Cell value in I8 is equal to 13, the required color when the
value is correct is Blue sky.

The Cell value in E10 is equal o 12, the required color when the
value is correct is Blue.
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12.

13.

14,

15.

16.

Merge cells L4:04, type " Rules in finding solution”

Format the cell to Size 12 and Bold, the font color is Dark blue,
the cell color is Rose.

Click menu Format>> Cells>>Alignment, align the font to the
Center both in horizontal vertical and directions, click OK.

Merge cells L5:05, type the following text 1. Let's calculate to
find the right number to fill in the red block in vertical and
horizontal directions. The answers in both will be equal.”

Merge Cells L6:06, type the following text " 2. Please notice the
red blank block, if the answer is correct the color of that block
will change to be in the same color as indicated in the row.”
Select the space in cells L5:L6, click Format>>Cells> > Alignment,
align the text in Horizontal direction to the Left (indent), and the
text in Vertical direction to the Center, then put the checkmark
Jwraptext  click OK. Format the font Size 10, and change the font
color of Rule 1 and Rule 2. to Dark blue.

Type Formulas and Functions to calculate Sub score as followings;
Cell P4, type =IF(64=8,1,0)

It means that if cell 64 is equal to 8, give 1 point, if not, give O.
Cell P5, type =IF(C6=9,1,0)

Cell P6, type =IF(E6=1,1,0)

Cell P7, type =IF(C8=4,1,0)

Cell P8, type =IF(68=3,1,0)

Cell P9, type =IF(18=13,1,0)

Cell P10, type =IF(E10=12,1,0)
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17.

18.

19.

20.

21.

22.

23.

24.

Merge cells L8:N8, type “"Scores”.

Format cell to Size 22, Bold with Dark blue, cell color is

Light orange.

Click Format>>Cells>>Alignment, align the font to the Center both
in Vertical and Horizontal directions. Click OK.

Merge cells L9:N10 to be used as the space for showing Score.
Set the font Size 36 and Bold, the color of the font should be

Red and the cell color is Yellow.

Click menu Format>> Cells>> Alignment, the font should be in the
Center both in Vertical and Horizontal directions, click OK.

Select cells L8:L9, click to select the border tool H All Borders
then click to the point cell.

Type Formulas and Functions to calculate the Total Score as
follows; In cell L9 type =SUM(P4:P10)

Hide the points by changing the font color in the cells P4:P10 to
White.

Merge Cells L1:M2 for placing the Hyperlink Picture

Click menu Insert>>Picture>>From File..>>, select

the required pictures, click OK. Adjust the size and put the picture
in the defined position.

Click cell N2, type ” Play Game”, adjust the font to Size 10 and
Bold, with Green.

Create the Solution of Number Finding Puzzle Game worksheet.
Change the name of Sheet 1 to SolutionNumber.

Right click on the SolutionNumber, select Moveor Copy...

select YiTreateacopy: click OK.
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25.
26.

27.

28.

When the SolutionNumber (2) appears,

change the name to PlayGameNumber.

In the Play6ameNumber change * Play Game" to “Solution”.
Create the link between Playing page and Solution page.

In the SolutionNumber, click in the picture in cell L1,
then click Insert Hyperlink &

When the Insert Hyperlink window appears,

select Place in this document.

For Cell Reference, select PlayGameNumber, click OK.

4 Cell Reference
,;ﬂ e
E;Egilrl;l_lentls SolutionMumber
Defined Mames

In the PlayGameNumber |, click the picture in cell L1, then click &,
When the Insert Hyperlink window appears,

select Place in this document.

For Cell Reference, select SolutionNumber, Click OK.

a - Cell Reference

& e

Place in This PlayGameNumber

Document e |
Defined Mames

Check the link between the 2 sheets to ensure that it can moved
forward and backward between PlayGameNumber and
SolutionNumber.
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29.

30.

3L

32.

33.

In the PlayGameNumber, delete the number in the following cells
64, C6, E6, C8, 68, I8 and E10, the cells will turn Red.

Unlock cell to be used as answering space, only in the PlayGameNumber
by click cell 64, then press Ctrl and click to select all the red cells
which are C6, E6, €8, 68, I8, and E10.

Click menu Format > >Cells> >Protection> >,

click [MlLlocked |ock to Locked  then click OK.

Create the Worksheet Protection.

Click menu Tools>>Protection>>Protect sheet.

The window for defining Password shall appear to let you define your
password (you can either define or reject to use Password).

Note : To define Password, you have to remember your password
otherwise you will not be able to edit your sheet again.

Click uncheck ¥l select locked cells to become L select locked cells
as shown in the picture;

Allow all users of this worksheet to: Allow all users of this worksheet to:
| select unlocked cells | select unlocked cells
Click OK.

It can be seen that all the cells are locked except the following cells:
G4, C6, E6,C8, 68, I8 and E10 which can fill in the number.

In the SolutionNumber worksheet,

Worksheet Protection by following the same procedures in item 31.

All the Cells will be locked in order that you can see only the solution.
For Editing, Click menu Tools >> Protection >> Unprotect Sheet...
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34.

35.

To Cancel the details of Program window elements,
click Tools >> Options... »>View

click to cancel the details which you would like to delete in both 2
sheefts such as

Formula bar Status bar Gridiines Row & column headers Sheet tabs

Click OK.
To Save Number Finding Puzzle Game
Click the PlayGameNumber sheet.

Click File>>Save As....>>type the name as Number Finding.
Click Save.
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The Colorful Balloons Game

%J File Edit W¥ew Insert Format Tools Data Window Help

BHRS SR VR ¥

Arial

W

Type onforkelp » o @ X
ER - %Z-%lkl @ 4% 1w00% - @
E;ﬁ @% y %0 ;00 ‘_ e Bl A'g

The Colourful Balloons,

-0 +|B.I U

e

v

i
There are many colorful balloons, but the shop owner has not yet color the balloons, :
let's the children help in putting the spelling of each color in English into the grey space ——
of each balloon, then you will see colorful balloons
; ; |
| lpeurp energ kinp lewyol _

Game Page for the player

M1



Solution to the Colorful Balloons Game

%j File Edit W¥ew Insert Format Tools Data Window Help

Typeaquestonforhelp - o F X
DEHRS SRIPRISRA- I 9-C- B2 @dwx -@f
Arial -0 - B 7 U S=E=H @y s 00 EE g-&-é-é %%%Iﬁ%g
pn J f
The Colousful Balloons; 'ir—’| |
There are many colorful balloons, but the shop owner has not yet color the balloons, —
let's the children help in putting the spelling of each color in English into the grey space Pla
of each balloon, then you will see colorful balloons. ¥

kinp lewyol
yellow

The outlook of the Solution Page when the answer is correct.
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The Colorful Balloons Game

DEHRS SRAIVEEE

Arial -5 -|[B|r O
N26 - A blue
\ B [ D

There are many colorful balloons, but the shop owner has not yet color the balloons,
let's the children help in putting the spelling of each color in English into the grey space Pla
of each balloon, then you will see colorful balloons. v

lewyol
yellow

The outlook of the Game which the details have not been deleted yet.
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[ The Colorful Balloons Game

# Game Building Procedures and Methods
Build up the game in Bookl by starting from Sheet 1.
Adjust the height of the row 25-27 to 25.
Adjust the width of columns A,C,E,6, I, K,M to 3 and columns
B,.D,F,H,J,L N 1015.
Merge cells C1:K5 for placing the name of game " Colorful Balloons
Game”, Adjust the position of the name of game properly.
Merge cells C6:K9, type the game rules as follows " In a balloons
shop, there are many colorful balloons, but the shop owner has
not yet color the balloons, let's the children help in putting
the spelling of each color in English into the grey space of each
balloon, then you will see colorful balloons.”
Set the text of the rules to font Size 11 and Dark blue.
Click menu Format>>Cells>>Alignment, align the text in Horizontal
direction to the Left (indent), and the text in Vertical direction to
the Center, then put WiWraptext ~Click OK.
Merge cells o use the area for coloring the balloons as to the
following requirements:
Cells B12:B18 Red balloon Cells D12:D18 Orange balloon
Cells F12:F18 Purpleballoon Cells H12:H18 Green balloon
Cells J12:J18 Pinkballoon  CellsL12:L18 Yellow balloon

Cells N12:N18 Blue balloon
Type the font in cells and change the cells color as to the following
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requirements ( ):

Cell B25 , type edr (orange)

Cell D25 , type gareno (light orange)
Cell F25 , type Ipeurp (lavender purple)
Cell H25 , type energy (light green)

Cell J25 , type kinp (rose pink)

Cell L25 , type lewyol (light yellow)
Cell N25 , type ubel (light blue)

Select the area of cells B25:N27, Format the cell to Center and set

the font to Size 16 and Bold.

7. Click cells B26,D26,F26,H26,J26,L26,N26 to change their cell

color to Grey-25% as shown in the picture.

A B [ D E F G H J K L [m] N
¥ (34 I 3 [’
The Colourfull Balloons,
There are many colorful balloons, but the shop owner has not yet color the balloons,
let's the children help in putting the spelling of each color in English into the grey space
g of each balloon, then you will see colorful balloons.
gareno Ipeurp energ Kinp lewyol ubel
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10.

Type the solution of the correct color in row 26, the Grey-25%
cell as follows:

B26 is Red D26 is Orange F26 is Purple H26 is Green
J26 is Pink L26 is Yellow N26 is Blue

Click cell B26 to select menu Format>>Conditional Formatting..
When Conditional Formatting window appeared, set up as according
to the picture:

Cell Value | | equal to * | |[="red”

It means that if the cell value is Red, the condition is true,

click

In the window of Format Cells, click Pattern, select Red and click OK.
The outcome will be displayed as in the picture, click OK.

| G—— ==

Condition 1

[ENEIREN ~ | [equal to - | |=Ted"
e g oo | [ S
when condition is true: Format...

| Add>> || Delete. | [ ok || cancel |

Try typing the font in cell B26, if the cell value is not red, the cell
color will remain 6rey-25%. If the cell value is Red, the cell color
will be Red.

Set Conditional Cell Formatting to the following Grey-25% cells
i.e. D26,F26,H26,J26,L26 and N26, using the same procedures as
initem 9, to define the correct solution and the cell color when the
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11.

12.

value in the cell is corrected as follows:

Cell value D26 is Orange Orange pattern
F26 is Purple Plum purple pattern
H26 is Green Green pattern
J26 is Pink Pink pattern
L26 is Yellow Yellow pattern
N26 is Blue Light blue pattern

Set Conditional Formatting in the following cells
B27,D027,F27,H27,327,L27 and N27 by using the same procedure
as initem 9, set up the correct answering value and the cell color
when the value is true as followings:
Cell value in B27 is “funas” White Font Red Pattern
D27 is "ad” White Font Orange Pattern
F27 is "“@ih"  White Font  Plum Purple Pattern
H27 is “#in"  White Font  Green Pattern
J27 is “avwy”  White Font Pink Pattern
L27 is “dmaes” White Font  Yellow Pattern
N27 is “#i” White Font  Light Blue Pattern

Type Formulas and Functions to automatically show the color name in
row 27, when filling in the correct color name, in cell B27 type
=IF(B26="red", "duad"," "), it means that if cell B26 has the wording
Red, the word &uas will show up, if it is not that word, let it be blank.
Cell D27, type =IF(D26="orange",“aé". " ")

Cell F27, type =IF(F26="purple”,“®in:". * ™)

Cell H27, type =IF(H26="green","aiun". " ")

Cell J27, type =IF(J26="pink","duuy". * ™)
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13.

14.

15.

Cell L27, type =IF(L26="yellow", “dmaes". " ™)

Cell N27, type =IF(N26="blue","&iau". * *)

Click to select the area of cells B25:B27, D25:D27, F25:F27,
H25:H27, J25:J27, L25:L27, N25:N27. click Toolbars, select
Border H , All Borders the color name cell.

Type Formulas and Functions so that cell can automatically change
the color, when the correct color name is filled up.

Cell B12, type =B26

It means that if cell B26 has any data, cell B12 will show the same
data.

Cell D12, type D26 Cell F12, type =F26
Cell H12, type H26 Cell J12, type =J26
Cell L12, type L26 Cell N12, type =N26

Set Conditional Formatting to the cells of balloons color which are
B12, D12, F12, H12, J12,L12 and N12, by using the same
procedure as in item 9. Then set up the correct answer and the cell
color when the value is ftrue as followings:

The value in cell

B12 is red With red pattern

D12 is orange With orange pattern

F12 is purple With plum purple pattern
H12 is green With green pattern

J12 is pink With pink pattern

L12 is yellow With yellow pattern

N12 is blue With light blue pattern
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16.

17.

18.

19.

Hide the text in the balloons, change the color of the text in the
following cells B12,D12,F12,H12,J12,L12 and N12 into the same
color as the cells, for example if the Cell is red, the letter should be
changed to red.

Click menu Insert>>Picture>>From File..>> select the

picture from CD-Rom named balloon.gif, click Insert.

Format the picture to be in the position which cover the

set up color in Row 12.

Click the balloon picture, use the set transparent color Y from
the Toolbar Picture.

Click in the balloon to fade out the former color of the balloon, the
space will come out to show the set up color. Copy the balloon
picture, to cover all the set up color cells.

Merge cells N2:N7 for placing the picture

Click menu Insert>>Picture>>From File..>> select the required
pictures. Click OK, adjust the size and place the picture into the
defined position.

Click cell N8, type " Play Game”, format the font to Size 10, Bold
and Green.

Create the Solution of The Colorful Balloons Game worksheet.
Change the name of Sheetl to SolutionBalloons.

Right clic}f___g__r_y____’[hg__?oIuTionBaIIoons , select Moveor Copy...

select Ylgreateaconyi OK.

When the SolutionBalloons (2) appears,

change the name to PlayGameBalloons.

In the PlayGameBalloons , change "Play Game" to " Solution”.
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20.

21

22.

23.

24.

Create the link between Playing page and Solution page.

In the SolutionBalloons, click in the picture

in cell N2, then click Insert Hyperlink ‘.

When the Insert Hyperlink window appears, select Place in this document
For Cell Reference, select PlayGameBalloons Click OK.

4 - Cell Reference

2 PlayGameBalloons|
Place in This
T SolutionBalloons
Defined Mames

In the PlayGameBalloons, click the picture in cell N2, then click &
When the Insert Hyperlink window appears, select Place in this document.
For Cell Reference, select SolutionBalloons. Click OK.

a - Cell Reference

%] v
Place in This PlayGameBalloons
Docurment I:l
Defined Mames

Check the link between the 2 sheets to ensure that it can be moved
forward and backward between PlayGameBalloons and
SolutionBalloons.

In the PlayGameBalloons, delete the data in the following cells B26,
D26, F26,H26, J26, L26 and N26, the cells will be displayed as
6rey-25% , the set up color of the cells will not show up.

Unlock cell o be used as answering space, only in the
PlayGameBalloons.

Click cell B26, press Ctrl then click Grey-25% in all the following
Cells B26,D26,F26,H26,J726,L26 and N26.

Click menu Format>>Cells> >Protection..

click [¥|Locked to [llocked | then click OK.
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25.

26.

27.
28.

29.

Create the Worksheet Protection

Click menu Tools>>Protection>>Protect sheet.

The window for defining password shall appear to let you define your
password (you can either define or reject to use Password)

Note : To define Password, you have to remember your password
otherwise you will not be able to edit your sheet again.

Click uncheck ¥ select locked cells to become [ select locked cells
as shown in the picture.

Allow all users of this worksheet to: Allow all users of this worksheet to:
| Select unlocked cells | Select unlocked cells
Click OK.

All the cells are locked, only the grey cells which can fill in the data
In the SolutionBalloons worksheet, you have to lock all worksheets
by following the procedure in item 25. It can be seen that all the
cells are locked for seeing solution only.
For Editing, Click menu Tools >> Protection >> Unprotect Sheet...
To Cancel the details of the window components,
Click Tools > Options... >> View
Click to cancel the details which you would like to delete in both 2
sheets such as

Formula bar Status bar cridlines Row & column headers Sheet tabs
Click OK.
To Save The Colorful Balloons Game. Click PlayGameBalloons sheet.
Click menu File>>Save As...>>type the name as Colorful Balloons,
Click Save.



The Ladder Puzzle Computer Game

@J File Edit W¥ew Insert Format Tools Data Window Help
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Arial 12 -||B|r O

Puzzle Solving Method

Solution

This game is like the crossword game.
There will be 2 alphabets for each word.
Please read the meaning of the word both
in vertical and horizontal lines. Then fill in
the rest of the alphabets in the red gap.
If you can fill in the right alphabets, the
colour of the cell will change into yellow.

1. Autormaton
2 Delete

3. Diagram , Graph

4 The word opposite "merge"
5 Empty

6. The button for turning on

7. Mistake

8. The machine stops its operation
9. The beginning

10. The computer language

1. To order to printer

12. Restarting

Game Page for the Player
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Solution to The Ladder Puzzle Computer Game

El_] File Edit W¥ew Insert Format Tools Data Window Help Typeaquestion forkelp = o @ X
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The Ladder Ruzzle Computesn

Puzzle Solving Method 7

This game is like the crossword game.
There will be 2 alphabets for each word.
Please read the meaning of the word bath 2
in vertical and horizontal lines. Then fill in
the rest of the alphabets in the red gap.
If you can fill in the right alphabets, the
colour of the cell will change into yellow.

1. Autormaton

2 Delete

3. Diagram , Graph
4 The word opposite "merge" >
5 Empty

6. The button for turning on

7. Mistake

8. The machine stops its operation
9. The beginning

10. The computer language

12 [l EB E - Z . 11. To order to printer

12. Restarting L

The outlook of the Solution Page when the answer is correct.
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The Ladder Puzzle Computer Game

EI_J Eile Edit W¥ew Insert Format Tools Data Window Help Type a question f =/ I D 4
DEHRS GRITE$BR-F9-C-(2z-4 i@ -0
Arial - 12 - o === = 3 I
JalslelplelrlelH[t[J[K[LIM[N]JOJP[Q[R[S|T[HIV|W X ¥ |
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: The LadderRuzzle Computes ]
[
A Y S S S| S
5 Puzzle Solving Method T Play Game
5 This game is like the crossword game. T — L
7 There will be 2 alphabets for each word. ]{ i Im ]
5 Fleasg read the meanmg.of the word bqth 2 P oo
in vertical and horizontal lines. Then fill in
1B the rest of the alphabets in the red gap. 2 Delete
10 If you canfill in the night alphabets, the 3 Diagram , Graph -

color of the cell will change into yellow.

11 4. The word opposite "merge"”

2 5. Empty

13 6. The button for turning on

G/ - L
16 7. Mistake

ﬁ' 8. The machine stops its operation
-15 9. The beginning

E 10. The computer language

= :
20 & R En 11. To order to printer

12. Restarting

& D\dwanumlsn... Ps Adobe Phot

The outlook of the Game which the details have not been deleted yet.
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U The Ladder Puzzle Computer Game

+#” Game building Procedures and Methods
1. Build up the game in Book 1 by starting from Sheet1.
Adjust the width of column A fo column W to be at 4.00 ( 33 Pixels)
Adjust the height of row 1 to row 21 to be at 20.00 ( 27 pixels)
3. Merge Cells A1:S3 for placing the name of game * The Ladder
Puzzle Computer” , Adjust the position of the name of game
properly as shown in the picture.
AlB[CID[EJF[GIHIT[J[KJL[M[N[O|JP[O[R[S|T[U[V W

1
R

The Ladder Ruzzle Computes

w o |~ o | s R |
m
o

ey
= s
v~
A
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Type the number and the English letters in the cells

Starting from

U1, typel U2 , type R U5, typeO R4, type?2
R5, typeE R8, type S Q5, type7 07, type3
O11, typeR | N8, type8 08, typeC L10, type 4
L11, typeS L14, typel K11, type9 I13, typeb
I14, typeB I17, typeN H14, type10 |F16, type6b
F17, type P F20, type E | E17, typell |C20, type R
B20, typel2

5. Click in cell U2, then press and hold Ctrl for a while, then click to
select the following cells U2:U6, R5:V5, R5:R9, 08:58, 08:012,
L11:P11, L11:L15, T14:M14, TI14:118, F17:J17, F17:F21 and
C20:620.

Format the cells to Size 12, color to Red, Bold , click to select Tools
border, EH All Borders the selected cells.

Click Format>> Cells>> Alignment, adjust the font to the Center
both in Vertical and Horizontal direction, click OK.

6. Format the Font as defined, click in cell U2, press Ctrl and hold for
a while click the following cells U5, R5, R8, 08, 011, L11, L14,
I14, T14, 117, F17, F20, and C20.

7. Format the numbers in the Vertical direction, click cell U1, press
Ctrl and hold for a while , then click the following cells R4, O7,
L10, I13, and F16. Set the font to Size 8.

Click menu Format>> Cells>> Alignment, set the font in Horizontal
position to be in the Center, and the font in Vertical position to be
Bottom, click OK.
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10.

11.

12.

13.

Format the numbers in the Horizontal direction, click cell Q5,
press Ctrl and hold for a while, then click the following cells N8,
K11,H14,E17, and B20, adjust the font to Size 8.

Click menu Format>> Cells>>Alignment, align the Horizontal font
to the Right(indent), and the Vertical font to the Center, click OK.
Adjust the width of column X to 23.00 (166 pixels)

Merge Cells X1:X4 for placing Hyperlink Picture

Click menu Insert>> Picture>> From File..>>, select the required
pictures, click OK.

Adjust the size and place the picture in the indicated position.

Click cell X5 and type * Play Game”, set the font to Size 10,

Bold and Green.

In cell W7, type "Vertical direction”, format the font to Size 10 and Bold.
Click cell W7, align the font to the Center, Bold and set the

Cell color to Lemon green.

Change the color of the cells W8:W13 into Light green.

Type the meaning of computer vocabularies respectively by using
Size 11 font as followings:;
W8, type 1. Automaton
W9, type 2. Delete
W10, type 3. Diagram , Graph
W11, type 4. The word opposite "merge"
W12, type 5. Empty
W13, type 6. The button for turning on
In cell W15, type the text ™ Horizontal direction”, adjust the font
to Size 12 and Bold.
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14.

15.

16.

Click cell W15 and adjust it to be in the Center, Bold and change
the cell color to Light orange. Change the cell color W16:W21 o Golden.
Type the meaning of computer vocabularies by using font Size 11

as followings:

W16, type7. Mistake

W17, type 8. The machine stops its operation

W18, type 9. The beginning

W19, type 10. The computer language

W20, type 11. To order to printer

w21, type 12. Restarting

Merge cells B5:ED, type "Puzzle Solving Method".

Format the cells to Size 12 and Bold, the font color is Dark blue, the
cell color is Rose.

Merge cells B6:J11, type "This game is like the crossword game.
There will be 2 alphabets for each word. Please read the meaning
of the word both in vertical and horizontal lines. Then fill in the
rest of the alphabets in the red gap. If you can fill in the right
alphabets, the color of the cell will change into yellow.”

Format the font in cell B6 to Size 11, the Font color is Dark blue.
Click menu Format > >Cells> > Alignment, align the Horizontal text to be
Left(indent), as for the Vertical text , align to the Center and put

/] wirap text click OK.

Click cell U3, select Format>>Conditional Formatting...

When the conditional formatting window appears, set up the
conditions as the shown picture

EENEMSEN ~ | equslto > | |="0"
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17.

18.

Condition 1
Cell Value w | |equal to - | |=10"7
Preview of format to use AaBbCcYvZz
when condition is frue: ¥ =

It means that if the cell value is equal to O, the condition is true

Click

In the conditional formatting window, click Pattern, select Yellow,
click OK.
The outcome will be displayed as in the picture, click OK.

| Add>> || Delete.. | | ok || cancal |

Try typing the letters in cell U3, you will see that if the cell value is
not equal to O, the cell color will remain Red. But if the cell value
is 0, the color will change to Yellow.

As for the following Red cells U4,U6, S5, T5, V5, R6, R7, R9,
P8, Q8, S8, 09, 010, 012, M11, N11, P11, L12, L13, L15,
J14, K14, M14, 115, 116, I18, 617, H17, J17, F18, F19,
F21, D20, E20, and 620, follow the same procedures as in item 16.
Type the answer letter in the following cells:

U4=B Ué6=T S5=R T5=R V5=R
R6=R R7=A R9=E P8=R Q8=A
S8=H 09=H 010=A 0o12=T M11=T
N11=A P11=T L12-P L13=L L15=T

J14=A K14=5 M14=P I15=L I16=A
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19.

20.

I18=K 617=R H17=1 J17=T F18=0
F19=wW F21=R D20=E E20=S 620=T

Recheck again from the following Solution:

Vertical Solution Horizontal Solution
1. Automaton ROBOT 7. Mistake ERROR
2. Delete ERASE 8. The machine CRASH

stops its operation

3. Diagram , Graph CHART 9. The beginning START
4. Th?T wo"rd " SPLIT 10. The computer BASIC
opposite "merge language
5. Empty BLANK 11. To order to printer | PRINT
6. The butfon for | o\ ep 12. Restarting RESET
turning on

Merge cells P15:U21, for placing the pictures about computer.

Click menu Insert>>Picture>>From File..., select the pictures from

CD- Rom. Click OK. Adjust the pictures in the indicated position.

Create The Ladder Puzzle Computer Game worksheet.

Change the name of Sheetl to SolutionLadder.

Right click on the SolutionLadder , select MoveorCopy...

When the SolutionLadder (2) appears,

change the name o the PlayGamelLadder.

In the PlayGameladder, change the word “Play Game" to"Solution”.
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21

22.

23.

24.

Create the link between Playing page and Solution page.
In the SolutionLadder, click the picture in cell X1,

then click Insert Hyperlink %

When the Insert Hyperlink window appears,

select Place in this document.

For Cell Reference, select PlayGamelLadder, click OK.

4 - Cell Reference

%]
Flace in Thi
Di.:ceulrr;.enf SolutionLadder
Cefined Mames

In the PlayGamelLadder, click the picture in cell X1,
then click Insert Hyperlink &

When the Insert Hyperlink window appears,

select Place in this document.

For Cell Reference, select SolutionLadder, Click OK.

= 4 - Cell Reference
H PlayGameladder
Place in This d
Document I:l
Defined Mames

Check the link between the 2 worksheets to ensure that it can be
moved forward and backward between PlayGamelLadder and
SolutionLadder.

In the PlayGamelLadder, delete the letters in the following cells:
U3, U4, U6 ,55, T5, V5, R6, R7, R9 , P8 ,Q8 , S8 , 09 ,
010, 012 , M11 , N11 , P11, L12, L13 ,L15, J14 6 K14,
M14 , 115, I16 , I18 , 617, H17 , J17, F18 , F19 , F21 ,
D20 , E20 and 620. The cells will be turned to Red.
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25.

26.

Unlock the cells to be used as answering space, only in the
PlayGamelLadder by click cell U3,then press Ctrl, and click to
select all red cells I.E.U4 ,U6 ,S5, T5, V5, R6, R7, 012,
M11 , N11 , P11, L12,L13,L15, J14, K14 ,6 M14 | I15,
I16 , 118, 617, H17 , J17 , F18 , F19 , F21 , D20 , E20 and 620.
Click menu Format>>Cells>>Protection, click [¥|Lodked to be | |Locked
Click OK.

Create Worksheet Protection

Click menu Tools >> Protection >»> Protect sheet

The window for defining Password shall appear to let you define your
password (you can either define or reject to use Password)

Note : To define Password, you have to remember your password
otherwise you will not be able to edit your sheet again.

Click uncheck ¥ select locked cells to become [ select locked cells
as shown in the picture:

Allow all users of this worksheet to: Allow all users of this worksheet to:
| select unlocked cells | select unlocked cells
Click OK.

It can be seen that all the cells are locked except the following cells;
U3,U4 ,U6,S5,T5,V5,R6,R7,R9,P8,Q8,58, 09,
010, 012, M11 , N11 , P11, L12, L13, L15, J14, , K14,
M14 |, 115, 116 , I18, 617 , H17, , J17 , F18 , F19, F21 ,

D20 , E20 and 620 which can fill in the letters.
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27.

28.
29.

30.

In the SolutionLadder worksheet, you have to lock all worksheets
by following the same procedure in item 26. It can be seen that all
the cells are locked for seeing solution only.

For Editing, Click menu Tools >> Protection >> Unprotect Sheet...
To Cancel the details of the window components,

Click menu Tools >> Options... >»>View

Click to cancel the details which you would like to delete in both 2
sheets such as

Formula bar Status bar cridlines Row & column headers Sheet tabs

Click OK.

To Save The Ladder Puzzle Computer Game

Click the PlayGamelLadder sheet.

Click menu File>>Save As..>>type the name as Ladder Puzzle.

Click Save.
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English Proverbs Games

%] File Edit W¥ew Insert Format Tools Data Window Help

DEHRS SR VE¥R&-F (I -0 - R -2 Eson -@f

Arial -2 - Blru EE=EHD% 0 83 j'&'é'g
[ = 1 b
English Rroverbs;
Proverbs The meanings Scores Solution
1
Total Scores
2 .
3 | )
4 | Cheer up!!
5 Please fill in the
English proverbs in
6 the blank which has =
the same meaning.
7
8
g
10
4 4 » W[\ PlayGameProverbs / SolutionProverbs £ DetaiProverbs / |1 . | v

Ready MUM

Game Page for the player
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Solution to the English Proverbs Game

@ File Edit W¥ew Insert Format Tools Data Window Help

DEHRS SR VEHR BRI
Arial =

50

Perfect!!

Please fill in the
English proverbs in
the blank which has
the same meaning.

5

' “hifinarlawiiauilaarm’ 5 =
A ,;?
| gl 5 PR

" {_"
4 4 » W]\ PRyGemeProverbs  SolutionProverbs | DetaiProverbs /
Ready

The outlook of the Solution Page when the answer is correct.
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English Proverbs Games

El;j Elle Edit W¥ew Insert Format Tools Data Window Help ~ -8 X
DEHRS SA VR $BR-F/I9-0- B -2 5 0H 0 -@)
Arial - 12 -E: o = _D@% v R = 'z"z-&vg-%

Al B | C [ E |F] G | | | [ 7‘
L) ! B
ETN English Proveshs, y
il I : R 1 ——
5] [ ] Proverbs The meanings 'Scores. Play Game
B

1
% _ Total Scores
»

10 _ _ . 50
IEE anwiEda dnna” | '
o] [ 4] faad Aliagifianu’ || Perfect!
14
15 5 (e Plezse fil in the L]
16 English proverbs in
17 8 the blank which has
_1_8 _ the same meaning.
I 5
21| | 8 No time like the present. Mbifvalawdiauiaar’ |
= 9 T i 5

late-to-never-learn-too

(3

24 L

25 |10

26 man-maketh-manners | | |2
4 4 v W[\ PRyGameProverbs / SolutionProverbs ) DetailProverbs / |« + [ v
Redy MM

The outlook of the Game which the details have not been deleted yet.



U The English Proverbs Game

# Game Building Procedures and Methods

Build up the game in Book1 by starting at Sheet1.

Adjust row 1 to row 26 to be 16.50 (22pixels)

Adjust the width in the required columns as followings:

Column A=5.00 (40 pixels) Column B=4.00 (33 pixels)
Column C=40.00 (215 pixels) Column D=5.00 (19 pixels)
Column E=35.00 (355 pixels) Column F=2.00 (19 pixels)
Column 6=10.00 (75 pixels) Column H=7.00 (54 pixels)
Column I=15.00 (110 pixels) Column J=7.00 (54 pixels)
Merge cells C1:64 for placing the name of game “English Proverbs”
Adjust the position of the name of game properly.

Type the required text as followings:

C5, type Proverb E5, type Meaning

G5, type Score

Format the cells into Size 12 and Bold, the font color is Dark blue.

B7 typel B9 type 2
B11 type 3 B13 type 4
B15type 5 B17 type 6
B19 type 7 B21 type 3

B23 type 9 B25 type 10
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6. Look at the example picture, type the required text as followings:

A E C [ D ] E ['E] G H
1
2 n i
4
5 Proverbs The meanings Scores
5]
7 1 "unsEnadindn Tl
g than-better-never-late
] 2 "erued Huenwsuskannada”
10 food-ig-music-love-of-the
11 3 "mida dhunn"
i power-knowledge-is
13 4 "gefufland Tlvaddaiu”
14 live-to-and-eat-not-eat-live-to
15 5 "FrduAdoaiaundudan”
16 me-love-dog-love-mys
17 6 gl LAt A
18 comes-never-tomorrow
19 7 "wdnldioau fuasTanTundda"
20 people-negative-avoid
21 8 "afnantaaliouila !
22 lilkke-no-prezent-time-the
23 9 lanafuldinsgous”
24 late-to-never-learn-too
25 10 "FRenunseny vinldeu Jusu”
26 marn-maketh-manners

C8 type than-better-never-late C10 type food-is-music-love-of-the
C12 type power-knowledge-is C14 type live-to-and-eat-not-eat-live-to
C16 type me-love-dog-love-my C18 type comes-never-tomorrow
C20 type people-negative-avoid €22 type like-no-present-time-the
C24 typelate-to-never-learn-too C26 type man-make-the-manners
E7, type "Late better than never.”

E9, type " Music is the food of love”

Ell, type "Knowledge is power."
E13, type " Eat to live, not live to eat.”
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E15, type " Love me , love my dog.”
E17 type " Tomorrow never comes."”
E19 type " Avoid negative people.”
E21 type ™ No time like the present.”
E23 type " Never too late to learn.”
E25 type " Manners make man.”

Format the font in cells €5,E5, 65 to Size 12 with Dark blue,
align the font to the Center. Format cell B7:€26 to Size 11 and
align the font to the Center.

Click to select cells and change the color in the following cells:
Press Ctrl, click to select cells €7, E7, 67, C17, E17, 617 and
change the cells color to Light orange.

Press Ctrl, click to select cells €9, E9, 69, C19, E19, 619 and
change the cells color to Lavender.

Press Ctrl, click to select cells €11, E11, 611, €21, E21, 621 and
change the cells color to Pale blue.

Press Ctrl, click to select cells €13, E13, 613, €23, E23, 623 and
change the cells color to Rose.

Press Ctrl, click to select cells €15, E15, 615, €25, E25, 625 and
change the cells color to Lime.

Press Ctrl, click to select cells €8, €18 and change the cells color o Red.
Press Ctrl, click to select cells €10, €20 and change the cells color to Violet.
Press Ctrl, click to select cells €12, €22 and change the cells color
to Light blue.

Press Ctrl, click to select cells C14, €24 and change the cells color to Pink.
Press Ctrl, click to select cells €16, €26 and change the cells color 1o Green.
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10.

11.

Press Ctrl, click to select cells €8, €10, €C12,C14, C16, C18, C20,
C22,C24 and €26, click menu Format>>Cells>>Border, select
Thick line, White color. Click to select Underline, click OK.

Then Type the correct answer of the proverb as following:

Cell C7,type Late better than never.
Cell €9, type Music is the food of love.
Cell €11, type Knowledge is power .

Cell €13,1ype Eat to live not live to eat.
Cell C15, type Love me love my dog.

Cell €17, type Tomorrow never comes.
Cell C19, type Avoid negative people .

Cell €21,type No time like the present.
Cell 623, type Never too late to learn.
Cell 625, type Manners make man.

Type Formula and Function to calculate the point as followings:
Cell 67, type =IF (C7=" Late better than never”, 5,0)

It means that if cell €7 has the data Late better than never, the
point will be 5, if not, the point should be O

Cell 69, type =IF (€C9="Music is the food of love.”, 5,0)

Cell 611, type =IF (C11="Knowledge is power.”, 5,0)

Cell 613, type =IF (C13="Eat to live, not live to eat.”, 5,0)
Cell 615, type =IF (C15="Love me, love my dog.”, 5,0)

Cell 617, type =IF (C17="Tomorrow never comes.”, 5,0)
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12.

13.

14.

15.

16.

17.

18.

19.

Cell 619, type =IF (€C19="Avoid negative people..”, 5,0)

Cell 621, type =IF (€C21="No time like the present.”, 5,0)

Cell 623, type =IF (623="Never too late to learn.”, 5,0)

Cell 625, type =IF (625="Manners make man.”, 5,0)

Format the data in the cell 67:625 to in Size 12 and Bold and align
the Center.

Merge cells I7:I8, type "Total Scores”, format the Cells to Size 12

,Bold and the font color is Dark blue while the cell color is

Light green.

Merge cells T9:I11 to be used for showing score.

Format the cells to be in Size 30, Bold with Pale blue.

Select the cells I7:I11, click the Tool Border H, All borders to
the scoring cell.

Type Formula and Function to calculate the total score as following;
Cell 19, type=SUM(67,69,611,613,615,617,619,621,623,65)
It means that the total score should be collected from the following
Cells 67,69,611,613,615,617,619,621,623,65.

Merge cells H13:J13 for using as the area for putting encouraging

terms to game player.

Click cell H13, type =IF(19>=30,"Perfectll”,IF(19>=20"Very Good!l",

IF(19>=10,"Good!", IF (19<10,Cheer upll"))))

Merge cells T21:I26 for placing a cartoon picture of a Thai child.
Click menu Insert>>Picture>>From File..>>, select the
pictures from CD-Rom, click OK. Adjust the size and place the
pictures fo be in the proper position.
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20.

21.

22.
23.

24.

From the Toolbar Drawing, click AutoShapes, select

Callouts, draw the callouts over the cartoon, type the text as
followings “Please fill in the English proverbs in the blank which
has the same meaning.Please fill in the English proverbs in the
space that suits to their meanings”.

Format the data to Size 10, font in Dark blue.

Merge cells I1:I4 for placing the pictures.

Click menu Insert>>Pictures>>From File..>>, select the pictures
as required. Click OK. Adjust the size and put the pictures in the
proper position.

Click cell I5, type “"Play Game", format to Size 10, Bold and Green.
Create the Solution of English Proverbs Game worksheet
Change the name of Sheet 1 to SolutionProverbs.

Right click on the SolutionProverbs , select MoveorCopy...

When the SolutionProverbs (2) appears ,

change the name to the PlayGameProverbs.

In the PlayGameProverbs, change the word "Play Game" to “Solution”.
Create the link between Playing page and Solution page.

In the SolutionProverbs, click the picture in cell I1,

then click Insert Hyperlink &

When the Insert Hyperlink window appears,

select Place in this Document.

For Cell Reference, select PlayGameProverbs, Click OK.

= 4 - Cell Reference
> PlayCameroverbs
Place in This
Document SolutionProverbs
Defined Mames
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25.

26.

27.

28.

29.

In the PlayGameProverbs, click the pictures in cell I1,
then click Insert Hyperlink ‘&

When the Insert Hyperlink window appears,

select Place in this Document.

For Cell Reference, select SolutionProverbs, Click OK.

= 4 - Cell Reference
H FlayGameProverbs
Place in This 4
Document I:l
Defined Mames

Check the link between the 2 worksheets to ensure that it can be
moved forward and backward between PlayGameProverbs and
SolutionProverbs.

In the PlayGameProverbs, delete the text in the following cells:

C9, C11, C13, C15, €17, €19, C21, C21, C23,and C25.

The scoring space is all O.

Unlock the cells to be used as answering space only in the
PlayGameProverbs by click cell C7 then press Ctrl, and click to
select the following cells €9,€11,C13,€15,C17,C19,€21,C23, and €25.
Click menu Format > >Cells> >Protection ,

click [¥Locked o be [ILecked (Click OK.

Create Worksheet Protection

Click menu Tools >> Protection >> Protect sheet

The window for defining Password shall appear to let you define your
password (you can either define or reject to use Password)

Note : To define Password, you have to remember your password
otherwise you will not be able to edit your sheet again.
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30.

31.
32.

33.

Click uncheck select locked cells to become [ select locked cells
as shown in the picture;

Allow all users of this worksheet to: Allow all users of this worksheet to:
| select unlocked cells | select unlocked cells
Click OK.

All the Cells are locked except for the following cells C7, €9,
Cl11, C13, C17, C19, €21, €23, and €25 which can type the text.
In the SolutionProverbs worksheet, you have to lock all worksheets
by following the procedure in item 29. It can be seen that all the
Cells are locked for seeing solution only.

For Editing, Click menu Tools >> Protect >> Unprotect sheet...

To Cancel the details of the window components,

Click menu Tools>»>Options...>>View.

Click to cancel the details which you like to delete in both 2 sheets
such as

Formula bar Status bar cridlines Row & column headers Sheet tabs

Click OK.

To Save The English Proverbs Game

Click the PlayGameProverbs sheet.

Click menu File>>Save As..>>, type the name as English Proverbs.
Click Save.
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How Many Game

%] File Edit W¥ew Insert Format Tools Data Window Help

DEHRS SR VE X

How many squares are there ?

numbers of triangles and
squares. Then fill in the
answer in the green gap.

Tnisdanisd...

W D:\dosasuidalszna,., L GameBulding101052..., | &) How Many Game.xis

Game Page for the player
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Solution for How Many Game

@J File Edit W¥ew Insert Format Tools Data Window Help

DEHRS SRIVE ¥R S @ E -2 R 0o - @ g
Arial -0 -[Blru sE=EED% 0 8 == s AT AE .
g’ Fl
How Many; Game; (B,
[
How many triangles are there ? -
' Play Game
Scores

6

Flease help us count the
numbers of triangles and
squares. Then fill in the
answer in the green gap.

How many squares are there ?

The outlook of the Solution Page when the answer is correct.
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How Many Game

@j File Edit W¥ew Insert Format Tools Data Window Help

DEHRS SR VR $GA-F(9-0- B -3 @0 -@F
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£ How Many; Game i [“,
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I How many triangles are there ?
6 Play Game

? 1

8

] Scores

o

6

Please help us count the
numbers of triangles and
squares. Then fill in the

How many squares: are there ? answer in the green gap.

& O \Gunduwicdanisa.. @@ D \dwmasuilsn.., I§ GameBulding 101052. . i_‘b Haw M'én!,- Game. ¥l

The outlook of the Game which the details have not been deleted yet.
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U How Many Game

/# Game Building Procedures and Methods
Build up the game in Book 1 by starting from Sheetl1.

Merge cells D1:J14 for placing the name of game "How Many Game".
Adjust the position of the name of game properly.

Merge cells E5:I5, type the question " How many triangles are there ?",
format the cell to Size 12, Bold, the color of the font is Dark blue
and the cell color is Gold.

Merge cells E20:I20, type the question " How many squares

are there ?” format the cell to Size 12, Bold, the color of the font

is Dark blue and the cell color is Gold.

Merge the following cells for placing all 6 drawings;

Merge cells B7:D16 for placing triangle 1

Merge cells F7:H16 for placing triangle 2

Merge cells J7:L16 for placing triangle 3

Merge cells B22:D31 for placing squares 1

Merge cells F22:H31 for placing squares 2

Merge cells J22:L31 for placing squares 3

Merge cells B17:B18, on the Toolbar Drawing click AutoShapes,
select 7 Basicshapes , Select /A draw the picture as required.

( press Shift and hold it for a while, during drawing in order to get
the equal sides of the shape.)

Click in the cell B17, click Copy fo place in cells F17 and J17 respectively.
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7. Merge cells B32:B33, in the Toolbar Drawing click AutoShapes,
select 7 Basicshapes , Select [ draw the picture as required.
( press Shift and hold it for a while, during drawing in order to get
the equal sides of the shape.)

Click in the cell B32, click Copy to place in cells F32 and J32 respectively.

8. Build up the answering cell by Merging cells C17:C18, click
Outside Border, change the cell color o Red with Size 18 , Bold.
Click in the cell C17 Copy to place in cells 617, K17, €32, 632 and
K32 respectively.

9.  Inthe Toolbar Drawing, click AutoShapes, select i} BasicShapes
select & and L draw all the 6 pictures as required ( press Shift and
hold it for a while, during drawing in order to get the equal sides of the
shape.) Al B c D E F G H i K L ]

How, Many, Gane

7
2
E;
4
5 How many triangles are there ?
6
7
8
9

10|
1
12
13
14
15

g T AL ] Al AL ]

20 How many squares are there ?

.25 1
27|
28

2z O | O[] O[]

10.  When finished to draw adjust the pictures grouping into the set up
position properly.
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11.

12.

Click C17 to sleect menu Format>>Conditional Formatting...,
when the Conditional Formatting window appears, set up as shown
in the picture

EENEMSE v | |equal to BE: &7

It means that if the Cell value is equal to 8, the condition is true.

Click

In the window Format Cells, click Patterns and select Lime ,
then click OK.
The outcome will be displayed in the picture, click OK.

Condition 1

FEEENSE ~ | |equalto - |8
ot o v AaBbCcYyZz
| Add>> || Delete.. | [ ok || cancel |

Try typing a number in cell C17, you will see that if the cell value is
not equal to 8, the Cell color is still Red. If the cell value equal to
8, the Cell color will change to Lime.

Set Conditional Formatting for the following cells 617, K17, €32,
632 and K32 by using the same procedures as in item 11. Set up the
value of the correct answer and the cell color when the value is true
as follow;

Cell 617 is 12, the cell color that should be changed when the value
is correct is Lime.
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13.

14,

15.

16.

Cell K17 is 12, the cell color that should be changed when the value
is correctis Lime.

Cell C32 is 6, the cell color that should be changed when the value is
correctis Lime.
Cell 632 is 7, the cell color that should be changed when the value is
correct is Lime.
Cell K32 is 9, the cell color that should be changed when the value is
correct is Lime.

Type the answer of the correct number as follows:

Cell C19 is 8. Cell619is 12. CellK19is 12.
Cell C34 is 6. CellG34is7. Cell K34 is 9.
Type Formulas and Functions to calculate sub score as follows:

Cell €19, type =IF(C17=8,1,0)

It means that if cell C17 is equal to 8, give 1 point, if not , give O.

Cell 619, type=IF(617=12,1,0)

Cell K19, type=IFK17=12,1,0)

Cell C34, type=IF(C32=6,1,0)

Cell 634, type=IF(632=7,1,0)

Cell K34, type=IF(K32=9,1,0)

Merge cells N8:09, type “"Scores”.

Format cell to Size 40 ,Bold. Set the font color to Dark blue
Merge cells N10:014 to be used as the space for showing score.
Format the cell to Size 40 and Bold the font color is Red and the
cell color is yellow.

Click menu Format>>Cells>>Alignment, adjust the font to the Center.
Select cell N10, click to select the Outside Border
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17. Type Formulas and Functions to calculate Total score as follows:
In cell N10, type =SUM(C19,619,K19,C34,634,K34)

It means that to sum up the points from the following cells:
C19,619,K19,C34,634, and K34.

18. Hide the points by clicking to select cell C19, 619, K19, C34,634
and K34 and change the font color to White.

19.  Merge cells M24:033 for placing the picture.

Click menu Insert>>Picture>> From File...>>select picture
from the CD- Rom, click OK. Adjust the size of the picture and place
it in the properly position.

20. In the Toolbar Drawing, click AutoShapes> >Callouts, select Cloud
callout draw the picture, type the following text in the callouts
"Please help us count the numbers of triangles and squares.
Then fill in the answer in the green gap.”

Format the cell o Size 10 with the font color Dark blue.

21.  Merge cells N1:05 for placing the picture.

Click menu Insert>>Picture>>From File..>> and select pictures as
required. Click OK, adjust the size and place the pictures as indicated.

22. Merge cells N6:06, type "Play 6ame”, format the font to Size 10,
Bold and the font color is Green.

23. Create the Solution of How Many Game worksheet.

Change the name of Sheetl to the SolutionHowMany.
Right click on the SolutionHowMany, select Moveor Capy... |
When the SolutionHowMany (2) appears,

change the name to the PlayGameHowMany.
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24.

25.

26.

27 .

In the PlayGameHowMany, change the word "Play Game" to "Solution”.

Create the link between Playing page and Solution page.
In the SolutionHowMany, click the picture in cell N1,
then click Insert Hyperlink =

When the Insert Hyperlink window appears,

select Place in This Document.

For Cell Reference, select PlayGameHowMany, click OK.

- 4 - Cell Reference
I EﬂTh | |
Place in This
Document SolutionHowMarty
Defined Mames

In the PlayGameHowMany, click the picture in cell N1,
Then click Insert Hyperlink 2

When the Insert Hyperlink window appears,

select Place in This Document.

For Cell Reference, select SolutionHowMany, click OK.

4 - Cell Reference

‘3 Hi
PlayG wivl
Place in Thie dylbamenowMany
Document
Defined Mames

Check the link of the 2 worksheets to ensure that it can be moved

forward and backward between PlayGameHowMany and
SolutionHowMany.

In the PlayGameHowMany, delete the number in the following cells:
C17, 617,K17,C32,632 and K32. The cells will be turned to Red.
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28.

29.

30.

3L
32.

Unlock the cells to be used as answering space, only in PlayGameHowMany
by click cell €17, then press Ctrl, and click fo select all red cells i.e.
617, K17, €32,632 and K32.

Click menu Format > >Cells>>Protection>>,

click [¥llocked lock to [ILecked | then click OK.

Create Worksheet Protection

Click menu Tools> >Protection> >Protect sheet,

The window for defining Password shall appear to let you define your
password (you can either define or reject to use Password)

Note : To define Password, you have to remember your password
otherwise you will not be able to edit your sheet again.

Click uncheck ¥ select locked cells to become [ select locked cells
as shown in the picture:

Allow all users of this worksheet to: Allow all users of this worksheet to:
| select unlocked cells | select unlocked cells
Click OK.

It can be seen that all the cells are locked except the following cells:
C17, 617,K17, €32, 632 and K32 which can fill up the number.
In the SolutionHowMany worksheet, you have to lock all worksheet
by following the same procedure in item 29. It can be seen that all
the cells are locked for seeing solution only.

For Editing, click menu Tools>>Protection>>Unprotect sheet-...

To Cancel the details of Program window elements.

Click menu Tools>>Options...>>View.
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33.

Click to cancel the details which you like to delete in both 2 sheets
such as

Formula bar Status bar Gridiines Row & column headers Sheet tabs

Click OK.

To Save The How Many Game

Click the PlayGameHowMany sheet.

Click menu File>> Save as...>» type the name as How Many.
Click Save.
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Have Fun with Sport Gears Game

Format Tools Data Window Help
@ = -4] %l o -@

@_’I Eile Edit W¥ew Insert

DEHRS SRAVE $ER- %
Arial -5 -|[B|lz W || o8 o,y %2 8 H-S-A-B
=1, * ) . =
Have Eunwith Spost Gears, i
Let's type the word about each kind of sport in the green gap under the picture of each sport equipment. ‘ a&__
If you type the right word, the score will show up in the righthand corner far 1 mark.
Solution

The name of the sport which has already been used and scored will show the red symbol * at the back
Scores

BADMINTON.
BASEBALLI

ameBuiding 1010

Ready

Game Page for the player
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Solution to Have Fun with Sport Gears Game

B Fle Edt  Vew

Insert Format Tools Data

Window  Help

DEHRS SR IVE 2R

- o B8 X
@z -5 5 i 0 - @
Arial -1 -|[B|lr 0= By 4 w0 E

Have: Sun with Sport Geans

Let's type the word about each kind of sport in the green gap under the picture of each sport equipment.
If you type the right word, the score will show up in the righthand corner for 1 mark.
The name of the sport which has already been used and scored will show the red symbol * at the back.

e
}..'?
\

football tabletennis

badminton rollerblad

HOCKEY:
PETANQUE!

baseball

drasutenalsng.., @ GameBulding 101052,

The outlook of the Solution Page when the answer is correct.
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Have Fun with Sport Gears Game

'%] File Edit W¥ew Insert Format Tools Data Window Help a8 X
DEHRS SR VE @ 8z 3B 0 - @]
Arial -1 -|[B|l7 U : EH oy » 8 se v AL

A B c D E F G H | J K 5 M N 0 B

Have Eun with Spost Gears

Let's type the word about each kind of sport in the green gop under the picture of each sport equipment.
If you type the right word, the score will show up in the nghthand corner for 1 mark.
The name of the sport which has already been used and scored will show the red symbol * at the back.

A~
]

badminton rolierblad volleyball

raiky (RCTTICR I NCRENCS Y NCH P [ PG G B (S S S B () S G |
mm-—qum.b-_Lul\J_stm*—q-m-mbum_r::)mm""'mm‘b‘m'm"‘

petanque tennis

mat gl . ] am»ﬁu\ldim;l\]

The outlook of the Game which the details have not been deleted yet.

88



[ Have Fun with Sport Gears Game

+# Game Building Procedures and Methods

Build up the game in Bookl by starting from Sheetl1.

Adjust the width of column A=6 B=4 (=15 D=3 E=15 F=3
6=15 H=3 I=15 J=3 K=15 L=4 M=6 N=14 0=3 P=6.
Merge cells B1:L3 for placing the name of game “Have Fun with
Sport Gears Game” . Adjust the position of the name of game
properly.

Type the Rules of the game over 3 lines and set the font fo Size 11
and the font color o Dark blue.

Merge cells C4:K4, type "Please type the name of each sport in
the green box under the picture of indicated sport equipment”.
Merge cells C5:K5, type "If you type the correct name, you will
get 1 point. The score will be displayed on the right box".
Merge cells C6:K6, type "The name of the sports that already filled
in and got the point shall have the red mark * on the back"”.
Prepare the space for placing the picture of each sport totaling 15
pictures as follows :

Merge cells C10:C14  for placing Football Picture

Merge cells E10:E14  for placing Table tennis Picture

Merge cells 610:614  for placing Golf Picture

Merge cells I10:I14  for placing Swimming Picture

Merge cells K10:K14  for placing Basketball Picture

Merge cells C18:C22  for placing Takraw Picture
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Merge cells E18:E22
Merge cells 618:622
Merge cells T18:122
Merge cells K18:K22
Merge cells €26:C30
Merge cells E26:E30
Merge cells 626:630
Merge cells I26:130
Merge cells K26:K30

for placing Badminton Picture
for placing Roller Blade Picture
for placing Volleyball Picture
for placing Hocky Picture

for placing Baseball Picture

for placing Petanque Picture
for placing Tennis Picture

for placing Skiing Picture

for placing Boxing Picture

Click menu Insert>>Picture>>From File... select the picture from
CD-Rom and place it as defined in item 5.

A B c D

Siwie = m e e

E G H | J K L M

Have Eun with Sport Geans

Please type the name of each sport in the green box under the picture of indicated sport equipment.
If you type the correct name, you will get 1 point. The score will be displayed on the right box
The name of the sports that already filled in and got the point shall have the red mark * on the back.

o ©
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10.

11.

Merge cells C15:C16, set the font to Size 14 and Bold and set
the font color to Lime.

Click cell €15, click copy and paste in cells E15 , 615 , TI15 ,
Ki5 , €23 , E23 , 623 , I23 , K23 , €31 , E31
631 , I31 and K31.

Type the sports name in the following cells and set the cell color as follow:
N18= BADMINTON (Light Yellow)N19= BASEBALL (Yellow)

N20= BASKETBALL (Gold) N21= BOXING (Light Orange)
N22= FOOTBALL (Orange) N23= GOLF (Tan)

N24= HOCKEY  (Rose Pink) N25= PETANQUE (Lavender Purple)
N26= ROLLERBLAD (Pink) N27= SKI(Light Blue Turquoise)
N28= SWIM (Blue Turquoise) N29= TABLETENNIS (Blue Green)
N30= TAKRAW (Light Green) N31= TENNIS(Sea Green)

N32= VOLLEYBALL (Light Green)

Select the space of cells N18:N32 and align the font to Right
and set the font Size 10 and Bold.

Click menu Format >> Cells >> Border select Dot Line, then Outline
and click OK.

Type the correct answer in the following cells :

Cell C15, type FOOTBALL Cell E15, type TABLETENNIS
Cell 615, type GOLF Cell IT15, type SWIM

Cell K15, type BASKETBALL Cell €23, type TAKRAW

Cell E23, type BADMINTON Cell 623, type ROLLERBLADE
Cell I23, type VOLLEYBALL Cell K23, type HOCKEY

Cell €31, type BASEBALL  Cell E31, type PETANQUE

Cell 631, type TENNIS Cell I31, type SKI

Cell K31, type BOXING
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12.

13.

14,

Type Formulas and Functions to calculate sub score as following :
Cell €17, type =IF(C15="FOOTBALL",1,0)

It means that if there is the word "FOOTBALL" in cell C15, give 1 point,
if not, give O.

Cell E17, type =IF(E15="TABLETENNIS", 1,0)

Cell 617, type =IF(615="GOLF",1,0)

Cell I17, type =IF(I15="SWIM",1,0)

Cell K17, type =IF(K15="BASKETBALL",1,0)

Cell €25, type =IF(C23="TAKRAW",1,0)

Cell E25, type =IF(E23="BADMINTON",1,0)

Cell 625, type =IF(623="ROLLERBLAD",1,0)

Cell I25, type =IF(I23="VOLLEYBALL",1,0)

Cell K25, type =IF(K23="HOCKEY",1,0)

Cell €33, type =IF(C31="BASEBALL",1,0)

Cell E33, type =IF(E31="PETANQUE",1,0)

Cell 633, type =IF(631="TENNIS",1,0)

Cell I33, type =IF(I31="SKI",1,0)

Cell K33, type =IF(K31="BOXING",1,0)

Merge cells N9:010, type “Scores". Format the cell fo Center
and set the font to Size 16 and Bold. Set the cell color to Lime.
Merge Cells N12:015 for showing the score.

Format the cell to Size 30 and Bold and set the font color to Blue.
Then, set the cell color to Light green.

Click menu Format >> Cells>> Alignment, align the font fo Center
both Horizontal and Vertical directions. Click OK

Click cell N12, click Outside border
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Type Formulas and Functions to calculate score as follows:

Cell N12 = SUM(C17,E17,617,117,K17,€25,E25,625,125,K25,
C33,E33,633,133,K33)

It means that to sum up the score from the following cells:
Cc17,e17,617,117,K17,C25,E25,625,125,K25 ,C33,E33,633,1I33
and K33

Type Formulas and Functions for to show * behind the sports name
already filled in.

Cell 018, Type =IF(E25=1"'*""' n)

It means that if cell E25 has 1 point, the * mark will be displayed.
If not, it remains blank.

CG” 019' Type =IF(C33=1l"*"'" u)

Cell 020, type =IF(K17=1,"*""")

Cell 021’ Type =IF(K33=1,"*"’" n)

Cell 022, Type :IF(C17:1,H*II,II u)

Cell 023, Type :IF(GI7:1,H*"," u)

Cell 024, type =IF(K25=1,"*""")

Cell 025' Type :IF(E33=1’||*"’|' u)

Cell 026, Type :IF(GZ5:1,H*"," u)

Cell 027, type =IF(I33=1,"*"" ")

Cell 028, type =IF(I17=1,"*""")

Cell 029, type =IF(E17=1,"*" " ")

Cell 030, Type :IF(C25:1,H*II,II u)

Cell 031' Type =IF(633=1,"*"," u)

Cell 032, type =IF(I25=1,"*""")

Note : You can use Copy for typing formulas in cells having similar
data and then change the cell name.
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17.

18.

19.

20.

21.

22.

Select the space of cells 018:032 and set the font type to Angsana New
and the font Size 20 and Bold and the font color to Red.

Note : If the height of the rows having * is changed, you have to
adjust the row height to 12.75.

Hide sub score by setting the color of following cells to Black.
B8:L9 B10:B34 C33:L34 D10:D32 F10:F32
H10:H32 J10:J32 L10:L32 C17:K17  C25:K25
N33:034 N8:08 N11:011 N16:017

Merge cells N1:05 for placing the picture.

Click menu Insert > Picture>> From Files... > select the picture,
Click OK, then adjust the size of the picture and place it in the
indicated position .

Merge cells N6:06 for placing the word "Play Game".

Format the cell to Size 10, Bold and 6Green

Create the Solution of Have Fun with Sport Gears Game worksheet.
Change the name of Sheetl to SolutionSportGears.

Right click on the SolutionSportGears, select MoveorCopy...

select iCresteacopyt click OK.

When the SolutionSportGears (2) appears,

change the name to PlayGameSportGears.

In the PlayGameSportGears change the word "Play Game” to “Solution”.
Create the link between Playing page and Solution page.

In the SolutionSportGears , click the picture in cell N1,

then click Insert Hyperlink ‘&

When the Insert Hyperlink window appears,

select Place in this document.
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23.

24.

25.

26.

For Cell Reference, select PlayGameSportGears Click OK.

= 4 Cell Reference
p =
[?;;JI;EHES SolutionSportGears
Defined Mames

In the PlayGameSportGears, click the Picture in cell N1
then click Insert Hyperlink &

When the Insert Hyperlink window appears,

select Place in this document.

For Cell Reference, select SolutionSportGears Click OK.

4 - Cell Reference

PIgce%This FlayGameSportGears
Document | |
Defined Mames

Check the link between the 2 worksheets to ensure that it can be
moved forward and backward between PlayGameSportGears

and SolutionSportGears.

In the PlayGameSportGears, delete the sports name in cells
C15,E15,615,115,K15,C23, E23,623,123,K23,C31,E31,631,131
and K31 and remains blank.

Unlock Cell to be used as answering space, only in the
PlayGameSportGears by click cell C15, then press Ctrl,and click to
select answering cells which are E15,615,I15,K15,C23,E23,623,
I23,K23,C31,E31,631,131 and K31.

Click menu Format>>Cells>>Protection> >,

click [¥llocked lock to [ILecked | then click OK.
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27.

28.

29.
30.

Create Worksheet Protection

Click menu Tools>>Protection>>Protect sheet,

The window for defining Password shall appear to let you define your
password (you can either define or reject to use Password)

Note : To define Password, you have to remember your password
otherwise you will not be able to edit your sheet again.

Click uncheck ¥l select locked cells to become L select locked cells
as shown in the picture:

Allow all users of this worksheet to: Allow all users of this worksheet to:
| Select unlocked cells o | Select unlocked cells
Click OK.

It can be seen that all cells are locked except the following cells
C15,E15,615,115,K15,C23 E23,623,123, K23,C31,E31,631,131
and K31 which can fill in the answer.

In the SolutionSportGears worksheet, you have to lock all worksheets
by following the procedure in item 27. It can be seen that all the
cells are locked for seeing solution only.

For Editing, Click menu Tools >> Protection >> Unprotect sheet...
To Cancel the details of Program window elements.

Click menu Tools>>Options...>>View.

Click to cancel the details which you like to delete in both 2 sheets
such as

Formula bar Status bar cridlines Row & column headers Sheet tabs

Click OK.
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3L

To save The Have Fun with Sport Gears Game
Click the PlayGameSportGears sheet.

Click menu File >> Save as...>» type the name as Sport Gears.
Click Save.
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Let's Weaving Vocabularies Game
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There is a pair of rhyming words in this game  The alphabets in the middle inside the red gap will be the last
two alphabets of the word in the No.1 picture series. However, they will be the first two alphabets for the words in
MNo.2 picture Series. And if you want to know the meaning of the word, please over the mouse on the red triangle
of the picture. If your word is right, the word will appear with its meaning.
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Solution to Let's Weaving Vocabularies Game

@J File Edit W¥ew Insert Format Tools Data Window Help
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Let/s Weaving V. Vocabularies; | %
There is a pair of rhyming words in this game. The alphabets in the middle inside the red gap will be the last Play Game
two alphabets of the word in the No.1 picture series. However, they will be the first two alphabets for the words in
No. 2 picture Series. And if you want to know the meaning of the word, please over the mouse on the red triangle
of the picture_ If your word is right, the word will appear with its meaning. _|
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The outlook of the Solution Page when the answer is correct.
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Let's Weaving Vocabularies Game
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There is a pair of rhyming words in this game. The alphabets in the middle inside the red gap will be the last Play Game
two alphabets of the word in the No.1 picture series. However, they will be the first two alphabets for the words in
MNo.2 picture Series. And if you want to know the meaning of the word, please over the mouse on the red triangle
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The outlook of the Game which the details have not been deleted yet.
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[ Let's Weaving Vocabularies Game

# Game Building Procedures and Methods

Build up the game in Book1 by starting from Sheetl1.

Adjust the width of column following: A=3 , B-S=5, T=3 , U=25
Merge cells D1:Q4 for placing the name of game “Let's Weaving
Vocabulary Game”. Adjust the position of the name of game properly.
Adjust the Height of Row 5-8 to be equal to 15

Merge cells B6:T8 tfype "There is a pair of rhyming words in
this game. The alphabets in the middle inside the red gap will
be the last two alphabets of the word in the No.1 picture series.
However, they will be the first two alphabets for the words in
No.2 picture Series. And if you want to know the meaning of the
word, please over the mouse on the red triangle of the picture.
If your word is right, the word will appear with its meaning. "
Click menu Format >> Cell s>> Alignment, align the Horizontal text
to be Left(indent), as for the Vertical text, align to the Center and
put WWraptext Click OK.

Format the font toSize 11 and the font color to Dark Blue.

Merge cells U8:U9, type "Correct Vocabulary”. Format the font to
Size 12 ,Bold and cell color to Red.

Click menu Format >> Cells >> Alignment, align the text to Center
both in Horizontal and Vertical directions, click OK.

Merge cells, click menu Insert>> Comment and Insert>> Picture.
select the pictures from CD-Rom, click OK.

101



Cells E10:F13
Cells N10:013
Cells C14:D17
Cells Q14:R17
Cells F18:621
Cells N18:021
Cells E22:F25
Cells P22:Q25
Cells D26:E29
CellsP26:Q29
Cells E30:F33

Cells N30:033

Comment: Fishes which feed their calves with milk.
Picture: Whale

Comment: The parts of a tree.

Picture: Leaf

Comment: An animal which has the longest neck.
Picture: Giraffe

Comment: The outer covering of a bird.

Picture: Feather

Comment: A number which has a circle shape.
Picture: Zero

Comment: The flower which symbolizes love.
Picture: Rose

Comment: A wild animal which looks like a cat.
Picture: Tiger

Comment: The stationery for correcting wrong words.
Picture: Rubber

Comment: An equipment for recording pictures.
Picture: Camera

Comment: A Lovely pet with long ears.

Picture: Rabbit

Comment: A place where a human living.

Picture: House

Comment: It is name a cat but it is not a land animal.
Picture: Seal

Merge cells 611:612 and format the cell to Size 20 , Bold ,
then click Outside border
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10.

Format the font in the following cells by clicking cell 611 and

click Format Painter 7 and Paste incell H11, T11 , J11 , K11 ,
L11 , M11 , E15, F15, 615, H15 , I15, J15, K15 L15,
M15 , N15, 015, P15, H19 , I19, J19, K19, L19, M19 ,
623 , H23 , 123, J23 , K23, L23 , M23 , N23 , 023 , F27 ,

627 , H27 , 127 , J27 , K27 , L27 , M27 , N27 , 027 , 631 ,
H31 131, J31, K31, L31 and M31.
Type the vocabulary in the following cells as shown in the picture:
AlB[E[BD[ETFI[G [ H JIE[TL M [ NJTo[PlalRrR][S &5
1
2 L t
E Lets Weaying Vocabularies
4
5 There is a pair of rhyming words in this game. The alphabets in the middle inside the red gap will be the last
6 two alphabets of the word in the Mo.1 picture series. However, they will be the first two alphabets for the words in
7 Mo 2 picture Series. And if you want to know the meaning of the word, please over the mouse on the red triangle
3 of the picture. If your word is right, the word will appear with its meaning.
9
m o 1
: Q. [WA[ALE[ALF] ¥
14 y 1 h
¢ § COIRIAF[FIE[A[TIH[EIRIN\
18 - 3 s
1 ﬂ o
: z[E[R[o[sE] 4
22
%ﬁ\T\l\G\E\R\A\S\E\R\/
26
- .\c\A\mE\R\A\B\BmT\
29
30
3 =
HOUSEALk

Change the color of cell J11, K11, J15, K15, J19, K19, K23,
J23,727,K27,J31 and K31 to Red.
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Type Formulas and Functions in the cell to calculate Sub Score as
follows: 610 type =IF(611="W",1,0)
It means that if the alphabet in 611 is equal to “"W", give 1 point.

if not, give O.
Cell H10, type =IF(H11="H",1,0)
Cell L10, type =IF(L11="A",1,0)
Cell E14, type =IF(E15="6",1,0)
Cell 614, type =IF(615="R",1,0)
Cell T14, type =IF(I15="F",1,0)

Cell M14, type =IF(M15="T",1,0)
Cell O14, type =IF(O15="E",1,0)
Cell H18, type =IF(H19="Z",1,0)
Cell L18, type =IF(L19="S",1,0)
Cell 622, type =IF(623="T",1,0)
Cell I22, type =IF(I23="6",1,0)
Cell M22,type =IF(M23="S",1,0)
Cell 022,type =IF(O23="R",1,0)
Cell F26, type =IF(F27="C",1,0)
Cell H26,type =IF(H27="M",1,0)
Cell L26, type =IF(L27="B",1,0)
Cell N26,type =IF(N27="I",1,0)
Cell 630, type =IF(631="H",1,0)
Cell 130, type =IF(I31="U",1,0)
Cell M30, type =IF(M31="L",1,0)

Cell I10,
Cell M10,
Cell F14,
Cell H14,
Cell L14,
Cell N14,
Cell P14,
Cell I18,
Cell M18,
Cell H22,
Cell L22,
Cell N22,
Cell 622,

=IF(I11="A",1,0)
=IF(M11="F",1,0)
=IF(F15="1",1,0)
=IF(H15="A",1,0)
=IF(L15="A",1,0)
=IF(N15="H",1,0)
type =IF(P15="R",1,0)
type =IF(I19="E",1,0)
type =IF(M19="E",1,0)
type =IF(H23="T",1,0)
type =IF(L23="A",1,0)
type =IF(N23="E",1,0)
type =IF(623="T",1,0)
Cell 626, type =IF(627="A",1,0)
Cell 126, type =IF(I27="E",1,0)
Cell M26, type =IF(M27="B",1,0)
Cell 026, type =IF(027="T",1,0)
Cell H30, type =IF(H31="0",1,0)
Cell L30, type =IF(L31="A",1,0)

type
type
type
type
type
type

Note : Please note that every alphabet box which is not red cell will have

1 point displayed above. You can use Copy for typing formulas in
the cell having similar data and change the cell name.
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12.

Type Formulas and Functions to sum up Total Score and display the
Correct Vocabulary.
e Cell J13,type =SUM(610:I10) means to sum up the score of
610,H10 and T10 (3 cells)
Cell U11, type =IF(J13=3,"WHALE is mean darnw"," ")

It means that if the cell value of J13 is equal to 3, the meaning
of WHALE will be displayed.
Change the cell color of 611,H11 T11 and U11 to Light yellow.

e Cell K13, type =SUM(L10:M10)
Cell U12, type =IF(K13=2,"LEAF is mean wh"," ")
Change the cell color of L11,M11 and U12 to Lavender.
o Cell J17, type =SUM(E14:I14)
Cell U15, type =IF(J17=5,"GIRAFFE is mean &w"," ")
Change the cell color of E15,F15,615,H15,I15 and U15 to Yellow.
e Cell K17, type =SUM(L14:P14)
Cell U16, type =IF(K17=5,"FEATHER is mean wuun"," ")
Change the cell color of L15,M15,N15,015,P15 and U16 to Pink.
e Cell J21, type =SUM(H18:118)
Cell U19, type =IF(J21=2,"ZERO is mean wvgus"," ")
Change the cell color of H19,I19 and U19 tfo Gold.
e Cell K21, type =SUM(L18:M18)
Cell v20, Type =IF(K21=2,"RO$E is mean ﬂanqmm"," ")
Change the cell color of L19,M19 and U20 to Rose.
o Cell J25, type =SUM(622:122)
Cell U23, type =IF(J25=3,"TIGER is mean i&"," ")
Change the cell color of 623,H23,I23 and U23 to Light green.
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13.

14,

15.

Cell K25, type =SUM(L22:022)

Cell U24, type =IF(K25=4,"ERASER is mean ma"," ")

Change the cell color of L23,M23,N23,023 and U24 to blue sky.
Cell J29, type =SUM(F26:126)

Cell U27, type =IF(J29=4,"CAMERA is mean néowez"," ")
Change the cell color of F27,627,H27,I27 and U27 to Lime.
Cell K29, type =SUM(L26:026)

Cell U28, type =IF(K29=4,"RABBIT is mean nsee"," ")

Change the cell color of L27,M27,N27,027 and U28 to Pale blue.
Cell I33, type =SUM(630:I30)

Cell U31, type =IF(J33=3,"HOUSE is mean """

Change the cell color of 631,H31,I31 and U31 to Light green.
Cell K33, type =SUM(L30:M30)

Cell U32, type =IF(K33=2,"SEAL is mean wmmin"," ")

Change the cell color of L31,M31 and U32 to Light turquoise.

Note : Check the correct vocabulary in Column U in Solution to
Let's Weaving Vocabularies Game Page.

Hide the sub score by selecting all cells displaying Scores and
change the font color fo White.

Merge cells U1:U5 for placing the Picture.

Click Insert > Picture >> From File... >> select the picture and
click OK. Then adjust the size and place the picture in the indicated
position.

Click cell U6, type " Play Game". Format the cell to Center,

Size 11 , Bold and Green.
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16.

17.

18.

Create the Solution to Let's Weaving Vocabularies Game worksheet.
Change the name of Sheetl to SolutionWeaving.

Right click on the SolutionWeaving , select MoveorCopy...
When the SolutionWeaving (2) appears,

change the name to PlayGameWeaving.

In the PlayGameWeaving change "Play Game” o "Solution”.
Create the link between Playing page and Solution page.
In the SolutionWeaving, click the picture in cell U1,

then click Insert Hyperlink =

When the Insert Hyperlink window appears,

select Place in this Document.

For Cell Reference, select PlayGameWeaving, click OK.

_ 4 - Cell Reference
5]

Place in This II':l
Document SolutionWeaving
Defined Mames

In the PlayGameWeaving , click the picture in cell U1,
then click Insert Hyperlink &

When the Insert Hyperlink window appears,

select Place in this Document.

For Cell Reference, select SolutionWeaving, click OK.

= 4 - Cell Reference
%]

PlayGameWeavi

Place in This ayGameWeaving
Document
Defined Mames
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19.

20.

21.

Check the link between the 2 sheets to ensure that it can be moved
forward and backward between PlayGameWeaving and
SolutionWeaving.

Unlock cell to be used as answering space, only in PlayGameWeaving,
click to select cell 611 , H11 , T11 , L11 , M11 , E15 , F15 ,
615 , H15 , I15 , L15, M15 , N15, 015, P15, H19 , T19,
L19 , M19, 623 , H23 , 123 , L23 , M23 , N23,023 , F27 ,
627 , H27 , T27 , L27 , M27 , N27 , 027, 63, H31 , I31 ,
L31 and M31

Click menu Format>>Cells>>Protection> >,

click [MLlocked |ock to Locked | then click OK.

Click Delete to delete all alphabets in answering cells.

Create Worksheet Protection

Click menu Tools>>Protection>>Protect sheet,

The window for defining Password shall appear to let you define your
password (you can either define or reject to use Password)

Note : To define Password, you have to remember your password
otherwise you will not be able to edit your sheet again.

Click uncheck ¥ select locked cells to become [ select locked cells
as shown in the picture:

Allow all users of this worksheet to: Allow all users of this worksheet to:
| Select unlocked cells | Select unlocked cells
Click OK.

It can be seen that all the cells are locked except the cells in item 20
which can fill in the alphabets.
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22.

23.
24.

25.

In the SolutionWeaving worksheet, you have to lock all worksheets
by following the procedure in item 21. It can be seen that all the
cells are locked for seeing solution only.

For Editing, click Tools >> Protection >> Unprotect sheet...

To Cancel the details of Program window elements.

Click menu Tools >> Options... > View,

Click to cancel the details which you would like to delete in both 2
sheets such as

Formula bar Status bar cridlines Row & column headers Sheet tabs

Click OK.

To Save Weaving Vocabularies Game

Click the PlayGameWeaving sheet.

Click menu File>> Save as..>> type the name as Weaving Vocabularies.
Click Save.
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Fridge Hide and Seek Game

% File Edit W¥ew Insert Format Tools Data Window Help
DEHRS SR PEI¥BA-F(9-0-(@ -2 i @@ -0
Arial %49 -Er u §|§|§@@% y = = ':":'&'A'§

Fridge Hide and Seck,
These food, vegetables and fruits shall be kept fresher if you keep in a refrigerator. You have to fill

in the name of the food under its picture, then the alphabet having the number below shall present the
word ‘REFRIGERATOR"

]
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b
Il o W Il T o 0
10 9
1 2 3 4 5 8 7 8 9 10 2] 12
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(KA

Game Page for the player
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Solution to Fridge Hide and Seek Game

@j File Edit W¥ew Insert Format Tools Data Window Help Typeaquestionforhelp  « o & X
DEHRS SR VE¥R&-IF(9-0- (&= -2l i s -
e -2 - Bz v SEEED% 0 8 FFE E-2-A-0
14 e HidesaudlSesh £ P
Eridge Hide and| Sex | 28
These food, vegetables and fruits shall be kept fresher if you keep in a refrigerator. You have to fill Play Game

in the name of the food under its picture, then the alphabet having the number below shall present the
word ‘REFRIGERATOR"

P
2N o NN NN
'1'\ 4
B = E E E = i .
. & 11
B i B B
3 5
E BB EE
12 2 N
o 'R N e 28
1 ety
. e ﬁﬁ;,«
10 9
B E E E
7 6
REFRIGERATOR
EE B EDEEEEEBEE i
1 2 3 4 5 8 7 8 9 10 11 12
<] + | b:Jv
Dran+ g Autsshapes~ \ W IO H 4 BEH H-ZL-A-S=g @@
Ready MUM

o & O \Gunduwicdanisa.. @@ D \dwmasuilsn.., I§ GameBulding 121052

The outlook of the Solution Page when the answer is correct.
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Fridge Hide and Seek Game

@j Fle Edit Wwew Insert Format Tools Data Window Help Typea question forhelp = 2 -Close
DEHRS GRITE S B@- @ e - @)
Arial <10 £ B I O=E== =E e By A 1

A Bl C D EF|GIH I [J] K]LIM [N O [P Q [R| S |T| U[V] W]|X][ Y [Z] AA AB AC |AD| AE /AF] AG AH Al JAJ AK | —

L ; g5 1@ ;. } i
= E@@@; Hide and Seek | |1

4 These food, vegetables and fruits shall be kept fresher if you keep in a refrigerator. You have to fill Play Game
i in the name of the food under its picture, then the alphabet having the number below shall present the

? word ‘REFRIGERATOR"
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Ready

& O \Guadumiledanisd... W D \desaauigalsng.., @ GameBuilding 121052,

The outlook of the Game which the details have not been deleted yet.
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Fridge Hide and Seek Game

+# Game Building Procedures and Methods

Build up the game in Book1 by starting from Sheet1

Adjust the width of column
A,C.E.6,IK.M0,Q,5,UW,Y AA AC AE AG AL AK to 4

Adjust the width of column
B,D,F,HJLNPR,T,V,XZ AB,AD AF,AH,AJ fo 2

Adjust the height of row 1-30 to 17

Merge cells E1:Y3 for placing the name of game “Fridge Hide and
Seek Game". Adjust the position of the name of game properly.
Merge cells C4:AB6, type "These food, vegetables and fruits
shall be kept fresher if you keep in a refrigerator. You have to
fill in the name of the food under its picture, then the alphabet
having the number below shall present the word "REFRIGERATOR™"
Click menu Format >> Cells>> Alignment, align the Horizontal text to
Left(indent), as for the Vertical text, align to the Center and put
Jwraptext Click OK.

Format the font to Size 11 and the font color to Dark Blue.

Merge cells for placing the picture.

Click menu Insert>> Picture, select the pictures from CD-Rom as follows:
Cells B8:D10, Insert>> Picture “Shrimp”

Cells P10:R12, Insert »>Picture “Broccoli”

Cells F12:H14, Insert>> Picture “Fish”

Cells P14:R16 , Insert>>Picture “"Grapes”
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Cells D16:F18, Insert > Picture “Corn”

Cells P18:R20, Insert >>Picture “"Tomato”

Cells F20:H22, Insert >> Picture “Eggs”

Cells AD16:AJ21, Insert >»>Picture “"Refrigerator”

Format the cell color of E9 to tan and set the font to Center,
Bold, Brown and Size 14

Click cell E9, click Format Painter 7, then click in the following cells:
G9,K9,M9,09,511,W11,Y11 AA11 ,AE11,AG11,M13,013,515,
W15,Y15,AC15,617,I117,M17,U19,W19,AA19,AC19,K21 and 021
Type the alphabet in the following cells as shown in the picture:

AIBIlCIDIEIFIGIH[ I [J]K|LIMIN O Pl Q|R| S |T| U |VIW|X|Y |Z AAAH AC AD} AE |AF| AG AH Al

Fridge Hide and| Seck

These food, vegetables and fruits shall be kept fresher if you keep in a refrigerator. You have to fill
in the name of the food under its picture, then the alphabet having the number below shall present the
word ‘REFRIGERATOR”

@ |~ o [ e (R

Format the cell color of I9 to Lime and set the font to Center,
Bold, Brown and Size 14

Click cell I9, click Format Painter ¥ , then click in the following
cells: U11,AC11,T13,K13,U15,AA15,K17,519,Y19,I21 and M21
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10.

11.

Format the cell color E24 to Rose and set the font to Center,
Bold, Dark Blue and Size 14

Click cell E24, click Format Painter 7 , then click in the following
cells: 624,124,K24,M24,024,Q24,524,U24,W24,Y24 and AA24
Type the number to control cell as indicated as follows:

I10, type 4 V12, type 8 AC12, type 11 TI14, type 3
K14, type 5 U16, type 12 AA16, type 2 K18, type 1
S20, type 10 Y20, type 9 I22, type7 M22, type 6
E25, type 1 625, type 2 I25, type 3 K25, type 4
M25, type 5 025, type 6 Q25, type 7 S25, type 8
U25, type 9 w25, type 10 VY25, type 11  AA25, type 12
Format the cell having number o Size 8 and Bold.

Click menu Format >> Cells>> Alignment then align the Horizontal
text to Center and Vertical text to Top. Click OK.

Set Conditional Formatting as follows:

Click Cell I9, select Format>> Conditional Formatting..

When the Conditional Formatting window appears, set up as
according to the picture as shown.

[EENEMSEN ~ | | equalto - =R

It means that if the cell value is equal to R, the condition is true
Click

In the window Format cells, click Font select Brown and Bold,
Click Pattern, select Tan color, click OK.
The output will be displayed as in the picture, click OK.
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12.

13.

Preview of format to use AaBbCcYyZz
when condition is true:

l Add == ][ Delete... ] [ Ok ” Cancel ]

Try typing the numbers in cell I9, you will see that if the cell value
is not equal to R, the Cell color is still Lime. If the cell value is
equal to R, the Cell color will change to Tan and the Font color will
change to Brown.

As for the Lime cells which are U11,AC11,I13,K13,U15,AA15,
K17,519,Y19,121 and M21, execute Conditional Formatting in
every cells by following the same procedure in item 11

The alphabet in cell :

Ull is R AC11 isO I13 isF K13 isI
Ul5 isR AAl15 isE K17 isR 519 isT
Y19 isA I21 is E M21 is6

Type Formulas to link the alphabet for orderly arrangement. Click
cell E24, type =IF(K17="R","R"," ")

It means that if there is the alphabet "R" in cell K17, you will get R
in cell E24.

624 , type =IF(AA15="E","E"," ") 124, type =IF(I13="F""F"" ")
K24, type =IF(I9="R","R"," ") M24, type =IF(K13="T","I"," ")
024, type =IF(M21="6","6"," ")  Q24, type =IF(T21="E","E"," ")
S24, type =IF(U11="R","R"," ")  U24, type =IF(Y19="A","A" " ")
W24, type =IF(S19="T","T"" ") Y24, type =IF(AC11="0""O"" ")
AA24, type =IF(U15="R","R" " ")
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14,

15.

16.
17.

18.

19.

20.
21.

Merge cells AF6:AH6, type "Scores”. Format the cell to Size 12,
Bold and Blue green .

Merge cells AF7:AH8 for showing score. Format the cell to Size 26,
Bold and Light Green. Set the font color to Blue.

Select the space of cells AF6:AF7, click All Border H

Type Formulas and Functions to calculate Sub score as follows:

Cell E23, type =IF(E24="R",1,0)

It means that if there is the alphabet "R" in cell E23, give 1 point,
if not, give O.

Cell 623, type =IF(624="E",1,0) Cell I23,type =IF(I24="F",1,0)
Cell K23, type =IF(K24="R",1,0) Cell M23, type =IF(M24="T",1,0)
Cell 023, type IF(024="6",1,0) Cell Q23,type =IF(Q24="E",1,0)
Cell 523, type =IF(S24="R",1,0) Cell U23, type =IF(U24="A",1,0)
Cell W23, type=IF(W24="T",1,0) Cell Y23, type =IF(¥24="0",1,0)
Cell AA23, type=IF(AA24="R",1,0)

Note : If you fill in the correct answer, all cells in row 23 which
have formulas shall have "1 point” in the cell.

Type Formulas and Functions to calculate Total scores as follows
cell AF8, type =SUM(E23:AA23)

It means that to sum up the points of cells E23:AA23

Hide the Sub score by changing the font color of cells E23:AA23
to White.

Merge cells AD22:AJ23 for placing the word "REFRIGERATOR".
Type Formulas for automatically showing the word "REFRIGERATOR"

as follow:
=E24&624841248K24&M2440244Q2445244U248W2448Y24&AA24
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22.

23.
24,

25.

26.

27.

28.

Format the cell color AD22 to Light green and set the font to
Size 14,Bold and Dark blue.

Click menu Format > Cells>> Alignment, the font should be in the
Center both in Horizontal and Vertical directions. Click OK.
Merge cells AD24:AJ24 for placing the word "REFRIGERATOR"
Type Formulas for automatically showing the word "REFRIGERATOR"
as follow:

=IF(AD22="refrigerator"," "

Format the cell AD22 to Rose and set the font to Size 12, Bold and
Dark blue.

Merge cells AE1:AI3 for placing the picture.

Click menu Insert>> Picture>> From File.. >>, select the required
pictures, click OK.

Adjust the size and put the picture in the indicated position.

Click cell N2, type "Play Game". Set the font fo Size 10, Bold
and Green.

Create the Solution to Fridge Hide and Seek Game worksheet.
Change the name of Sheetl to SolutionFridge.

Right click on the SolutionFridge, select MoveorCopy..

select Vligeateaconyt click OK.

When the SolutionFridge (2) appears,

change the name to the PlayGameFridge.

In the PlayGameFridge change "Play Game” to “Solution”.

In the SolutionFridge, click the picture in cell AE1,

then click Insert Hyperlink =

When the Insert Hyperlink window appears,
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29.

30.

31.

32.

select Place in this Document.
For Cell Reference, select PlayGameFridge, click OK.

4 - Cell Reference

. FlayGameride]
Flace in This _ _
Document SolutionFridge
Defined Mames

In the PlayGameFridge, click the picture in cell AE1,
then click Insert Hyperlink =

When the Insert Hyperlink window appears,

select Place in this Document.

For Cell Reference, select SolutionFridge, click OK.

4 Cell Reference

b ] .
Place in This FlayGameFridge
Document
Defined Mames

Check the link between the 2 sheets fo ensure that it can be moved
forward and backward between PlayGameFridge and SolutionFridge.
Unlock cell to be used as answering space, only in the PlayGameFridge.
by click to select cells having the number under the food name which
are I9,U11,AC11,T13,K13,U15,AA15, K17,519,Y19,1I21 and M21.
Click menu Format>>Cells>>Protection> >,

click [MlLlocked |ock to Locked | then click OK.

Click Delete to delete all alphabet data in answering cells.

Create Worksheet Protection

Click menu Tools> >Protection>>Protect sheet,

The window for defining Password shall appear to let you define your

password (you can either define or reject to use Password)
119



33.

34.
35.

36.

Note : To define Password, you have to remember your password
otherwise you will not be able to edit your sheet again.

Click uncheck select locked cells to become [ select locked cells
as shown in the picture:

Allow all users of this worksheet to: Allow all users of this worksheet to:
| Select unlocked cells o | Select unlocked cells
Click OK.

It can be seen that all the cells are locked except the indicated cells
in item 31; which can fill in the number.

In the SolutionFridge worksheet, you have to lock all worksheets by
following the procedure in item 32. It can be seen that all the cells
are locked for seeing solution only.

For Editing, Click menu Tools >> Protect >> Unprotect Sheet...

To Cancel the details of Program window elements,

Click menu Tools >»> Options... > View,

Click to cancel the details which you would like to delete in both 2
sheets such as

Formula bar Status bar cridlines Row & column headers Sheet tabs

Click OK.

To Save Fridge Hide and Seek Game

Click the PlayGameFridge sheet.

Click menu File>> Save as..>> type the name Fridge Hide&Seek.
Click Save.



Locker Puzzle Game

E,j File Edit W¥ew Insert Format Tools Data Window Help

- -8 X
DEHRISISRIVE $aR-¢ SR s -l ALl oo - @ g
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Locken Ruzzle Game £
June has 9 keys altogether. She has already unlocked the lockers for 3 keys. June want to unlock the
rest of lockers. The problem is that the keys she want is fading. Please help June find the rest of the keys. Solution
. | »Rule for unlocking the Locker l
1. Bring the rest of the keys to fry unlocking the lockers by
& & typing the numbers in the blanks which has the lockers.
2 To help you unlock the locker more easily, Let have the
total number of all the lockers in vertical herizontal and
10 diagonal lines to be 15 +
T '

_ — E »MNumber of the keys s

& i

Game Page for the player
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Solution to Locker Puzzle Game

@J File Edit W¥ew Insert Format Tools Data Window Help Typeaquestionforhelp  « o & X
DEHRS SR VR BB - £ -0l il v - @
\Wingdings = 12 - b Iru == )l = EiE e B A LE
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Locker Ruzzle Game £
June has 9 keys altogether. She has already unlocked the lockers for 3 keys. June want to unlock the e

rest of lockers. The problem is that the keys she want is fading. Please help June find the rest of the keys. Play Game

| > Rule for unlocking the Locker l

1. Bring the rest of the keys to fry unlocking the lockers by
typing the numbers in the blanks which has the lockers.

2 To help you unlock the locker more easily, Let have the
total number of all the lockers in vertical herizontal and

10 diagonal lines to be 15 +
(T E »MNumber of the keys s
12348860
) 4360
s i) 1) ok
13

Scores Percent

6

100%

The outlook of the Solution Page when the answer is correct.
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Locker Puzzle Game

@J File Edit W¥ew Insert Format Tools Data Window Help
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Locker Ruzzle Game *—‘I )
June has 9 keys altogether. She has already unlocked the lockers for 3 keys. June want to unlock the
rest of lockers. The problem is that the keys she want is fading. Please help June find the rest of the keys. Play Game
1)‘Ru!e for unlocking the Locker J
1. Bring the rest of the keys to fry unlocking the lockers by
typing the numbers in the blanks which has the lockers.
2 To help you unlock the locker more easily, Let have the
total number of all the lockers in vertical herizontal and
10 diagonal lines to be 15 +
il E »MNumber of the keys s
_ ] L) | =l 13
' J U
- & U W
13 Scores Percent
100%
14
BE
16
7 )|
174 v W[\ PlayGamelocker / SolutionLocker ) DetailLocker,/ 5T + [ vl
Ready

The outlook of the Game which the details have not been deleted yet.
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[ Locker Puzzle Game

+# Game Building Procedures and Methods
Build up the game in Book1 by starting from Sheet1.
Insert the picture as the background of worksheet.
Click menu Format >> Sheet >> Background..,
Select the picture from CD-Rom, click locker.jpg, click Insert.
Merge cells A1:K4 for placing the name of game “Locker Puzzle
Game”. Adjust the position of the name of game properly.
Adjust the width and the height of cells
B10,D10,F10,B12,D12,F12,B14,D14 and F14 to be equal to the
width and the height of the Locker as shown in the picture.
Type the number in cells B10 , F12 and D14 as shown in the picture:

A B € D E F G H J K 5

Lockes Buzzle Game

Con| i ] B ha|

10
"

12
13

14

18
16

Format the cells B10:F14 to Size 48 and Bold.
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Click menu Format > Cells>> Alignment, align the text to the Center
both in Horizontal and Vertical directions, click OK.

Set the cell color of cells B10, F12 and D14 to Red.

Merge cells B5:K7, type "June has 9 keys altogether. She has
already unlocked the lockers for 3 keys. June want to unlock the
rest of lockers. The problem is that the keys she want is fading.
Please help June find the rest of the keys"

Set the font cell B5 to Size 11 and set the font color to Dark blue.
Click menu Format > Cells >> Alignment, align the Horizontal text to
left and Vertical text to Center and put Mlwraptext Click OK.

Click cell D10, select Format > Conditional Formatting..

When the Conditional Formatting window appears, set up as
according to the picture as shown:

Cell Value = | |equal to -| |1

It means that if the cell value is equal to 1, the condition is true
Click

In the Cell Formatting window, click Pattern, select Red, click OK.
The output will be displayed as in the picture, click OK.

Condition 1

* | |equal to - |1
il
when condition is true: Faormat...

| add>> || Delete.. | [ ok || cancel |
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10.

Try typing the numbers in cell D10. It can be seen that if the cell
value is not equal to 1, the cell color is still white with the picture
of key. But if the cell value is equal to 1, the cell color will change
to Red without the picture of key.

Set Conditional Formatting for cells having keys comprising cell
F10,812,D12,B14 and F14 by following the same procedure in item 7
Cell value of D10 is equal to 1

Cell value of F10 is equal to 6

Cell value of B12 is equal to 3

Cell value of D12 is equal o 5

Cell value of B14 is equal to 4

Cell value of F14 is equal to 2

Note : Type the correct numbers in every lockers, the cell color will
change to Red.

Type Formulas and Functions to calculate Sub scores as follows:
Cell D9, type =IF(D10=1,1,0)

It means that if the cell value of cell D10 is equal to 1, give 1 point,
if not, give O.

Cell F9, type =IF(F10=6,1,0)

Cell B11, type =IF(B12=3,1,0)

Cell D11, type =IF(D12=5,1,0)

Cell B13, type =IF(B14=4,1,0)

Cell F13, type =IF(F14=2,1,0)

Merge cells H8:J9, click menu Insert >> Symbol, select the
required symbol. Click Insert, type "Rule for unlocking the Locker”
Format the cell H8 to Size 11 and Bold. Set the font color to Blue
and cell color to Light Green.
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11.

12.

13.

14.

15.

16.

Click menu Format >> Cell s>> Alignment then align the text o the
Center both Horizontal and Vertical directions. Click OK.
Merge cells H10:M10, type "1. Bring the rest of the keys to
try unlocking the lockers by typing the numbers in the blanks
which has the lockers. 2. To help you unlock the locker more
easily, Let have the total number of all the lockers in vertical
horizontal and diagonal lines to be 15.”

Format the cell H10 fo Size 11 and the font color to Teal green.
Clickmenu Format >> Cells >> Alignment, align the Horizontal text to
Left(indent) and Vertical text to Center and put [V uirsp text

Click OK.

Merge cells H11:J11, click menu Insert>> Symbol, select the
required symbol. Click Insert, type "Number of the keys” Set the
cell format as shown in item 10.

Click Insert WordArt 4l on toolbar Drawing, Create the number
1-6 for placing in cells H12 - M12.

Merge cells H13:T13, type “Scores” Set the cell format as shown
in item 10.

Merge cells L13:M13, type "Percentage” Set the cell format as
shown in item 10.

Merge cells H14:I14 for showing score.

Format the cell to size 60 and Bold. Set the font color to Red and
cell color to Yellow.

Click menu Format >> Cells>> Alignment, the font should be in the
Center both in Horizontal and Vertical directions. Click OK.
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17.

18.

19.

20.

21.

22.

23.

Type Formulas and Functions to calculate Total score as follows:
Cell H14, type =SUM(D9,F9,B811,D11,B13,F13)

It means to sum up the points in cells D9,F9,B811,D11,B13,F13.
Hide the sub score by changing the font size in cells
D9,F9,B11,D11,B13 and F13 to 1.

Merge cells J13:K14 for placing the picture.

Click menu Insert>> Picture >> From File.. >, select the pictures from
CD-Rom, click OK. Adjust the size and put the picture in the
indicated position.

Merge cells L14:M14 for showing Percentage.

Format the Cell fo size 24 and Bold. Set the Font color to red and
Cell color to yellow.

Click menu Format >> Cells>> Alignment then align the text to
Center both Horizontal and Vertical directions. Click OK.

Type Formulas and Functions to calculate Percentage as follows:
Cell L14, type =H14/6

It means that the point in cell H14 must be divided by the full
score.

Click menu Format >> Cells >> Number Select Number to Percentage
Click OK.

Merge cells L1:M6 for placing the Hyperlink Picture.

Click menu Insert>> Picture>> From File.. >>, select the pictures,
click OK.

Adjust the size of the picture and place it in the indicated position.
Merge cells L7:M7, type "Play Game” format the font to Size 10
Bold and Green.
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24.

25.
26.

27.

Create the Solution to Locker Puzzle Game worksheet.
Change the name of Sheetl to SolutionLocker.

Right click on the SolutionLocker , select WMoveorCopy...
When the SolutionLocker (2) appears,

change the name to the PlayGamelLocker.

In the PlayGamelocker, change the word "Play Game" to “Solution”.
Create the link between Playing page and Solution page.
In the SolutionLocker, click the picture in cell L1,
then click Insert Hyperlink =

When the Insert Hyperlink window appears,

select Place in this Document.

For Cell Reference, select PlayGamelLocker, click OK.

4 - Cell Reference

gﬂ S
Place in This
Boament: SolutionLocker
Defined Mames

In the PlayGamelocker, click the picture in cell L1,
then click Insert Hyperlink &

When the Insert Hyperlink window appears,

select Place in this Document.

For Cell Reference, select SolutionLocker, click OK.

= 4 - Cell Reference
H PlayGamelocker
Flace in This 4 :
Document I:l
Defined Names
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28.

29.

30.

3L

Check the link between the 2 sheets to ensure that it can be
moved forward and backward between PlayGamelocker and
SolutionLocker.

In the PlayGameLocker, delete the number in cells D10, F10,B12,
D12,B14 and F14, then you will see the picture of locker with key
over such cells.

Unlock cell to be used as answering space, only in the PlayGamelLocker
by click cells D10, press Ctrl and click to select answering cells
which are F10,B12,D12,B14 and F14.

Click menu Format>>Cells>>Protection> >,

click [MlLlocked |ock to Locked | then click OK.

Create Worksheet Protection

Click menu Tools>>Protection> >Protect sheet,

The window for defining Password shall appear to let you define your
password (you can either define or reject to use Password)

Note : To define Password, you have to remember your password
otherwise you will not be able to edit your sheet again.

Click uncheck select locked cells to become [ select locked cells
as shown in the picture:

Allow all users of this worksheet to: Allow all users of this worksheet to:
| select unlocked cells | select unlocked cells
Click OK.

It can be seen that all the cells are locked except the following cells:
D10,F10,B12,D12,B14 and F14 which can fill in the number.
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32.

33.
34.

35.

In the SolutionLocker worksheet, you have to lock all worksheets
by following the same procedure in item 31. It can be seen that all
the cells are locked for seeing solution only.

For Editing, Click menu Tools >> Protection >> Unprotect Sheet...
To Cancel the details of Program window elements.

Click menu Tools >> Options... > View.

Click to cancel the details which you would like to delete in both 2
sheets such as

Formula bar Status bar Gridiines Row & column headers Sheet tabs

Click OK

Note : In this game, you could not delete the head row and head
column otherwise the position of picture cell will not be in
the former position.

To Save Locker Puzzle Game

Click the PlayGameLocker sheet.

Click menu File>> Save as..>> type the name as Locker Puzzle.

Click Save.
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Cursed Angel Game

lg‘_] File Edit W¥ew Insert Format Tools Data Window Help T a qus ~ .8 X

DEHRS gl B ¥Ean-d 3 {4 0o - @ |
Arial -8 -8 == |- ACB
A B C D E F G H i J K L ] N (9] P Q R S T b=
1 Long time ago, there was an angel breaking the F
2 . heaven's rules. She, therefore, was cursed to stay \—“*‘J
i ﬁ RS GJJ A in the magic picture frame until there was someone I H |
: AR IR AL U good at mathematics can decode and open the i
i puzzle picture. The angel shall appear. \We hope
7 you can help the angel. Solution
8 The Missions to help Angel.
1. You have to fill the answers in 24 blank boxes =
2. If your answer is correct, the box having the same f gﬁ.‘- BN
9 number as the answer shall be opened i.e. if the ‘ I FiFF
correct answer is "2", the second box shall be B 4 .
opened, If your answer is not correct, the box could T Sk 4 ‘.‘.
not be opened (Jki ":th
10 z
2x2 |20-4| 547 | 9-8 | 4x5 | 7+4 | 6x4 | 8-5 | 9+8 | 2x3 | 846 | 15-7

1§ unstied - Paint Microsoft Excef - C...

Game Page for the player
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Solution to Cursed Angel Game

% File Edit W¥ew Insert Format Tools Data Window Help Typ o sp o« o8 X
DEHRS SBITEHE ¥R~ SR T -G e @
Arial -8 -|[B|lr o =| | o o, <o | gr S AR
A [B] © | D | [ £ Jel # [EW J[®[L|[M[N[G[P[Aa[RI[SE[T]E
Lice il Long time ago, there was an angel breaking the ¥
-é—- heaven's rules. She, therefore, was cursed to stay
i in the magic picture frame until there was someone
R good at mathematics can decode and open the
= puzzle picture. The angel shall appear. We hope
""" you can help the angel.
8 - The Missions to help Engel.
1. You have to fill the answers in 24 blank boxes.
2. If your answer is correct, the box having the same
9 number as the answer shall be opened i.e. if the
i correct answer is “2, the second box shall be .
opened, If your answer is not correct, the box could
not be opened.
10
2x2 |20-4| 5+7 | 9-8 | 4x5 | 7+4 | 6x4 | 8-5 | 9+8 | 2x3 | 846 | 15-7
i
4116/12| 1 |20|11|24| 3 |17| 6 (14 8

The outlook of the Solution Page when the answer is correct.
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Cursed Angel Game

% File Edit W¥ew Insert Format Tools Data Window Help o o ow o B X
DEHRS SR VE($GR&-F(9-0- 2 =-0 il @awwe -0f
Arial -8 -|[B|lr o =| i b g w0 0§ we S AN

|

[ F Je|l # PR JIR[L[M[N][o[P|[alR[S[T]|HE

A | B | C | D |
Lice il Long time ago, there was an angel breaking the ¥
[ 2 heaven's rules. She, therefore, was cursed to stay
% linthe magic picture frame until there was someone
R |good at mathematics can decode and open the
= ‘puzzle picture. The angel shall appear. We hope
:_ \you can help the ar‘_l_g_e\.
8 ~ The Missions to help Angel.
1. You have to fill the answers in 24 blank boxes.
12_If your answer is correct, the box having the same
9 number as the answer shall be opened i.e. if the
s correct answer is “2, the second box shall be .
opened, If your answer is not correct, the box could
'not be opened.
10
2x2 |20-4| 5+7 | 9-8 | 4x5 | 7+4 | 6x4 | 8-5 | 9+8 | 2x3 | 846 | 15-7
i
4116/12| 1 |20|11|24| 3 |17| 6 (14 8

The outlook of the Game which the details have not been deleted yet.
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[ Cursed Angel Game

+# Game Building Procedures and Methods

Build up the game in Book1 by starting from Sheet1.
Insert the picture as the background of worksheet.
Click menu Format >> Worksheet >> Background..
Select the picture from CD-Rom, click Angel. jpg,
click Insert.
Merge cells A1:H6 for placing the name of game
“Cursed Angel Game".
Adjust the position of the name of game properly.
Adjust the column width as follow:

Column B and 6 =4.00

Column CtoF =9.57

Column ItoT =5.00
Adjust the Row Height as follow:

8 =21 9=50

10=50 11=50
12=50 13=50
14=50 15=21

Note : The height and the width are approximately set up for dividing
the picture to 4x6 boxes.
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15

2x2 |20-4|5+7 | 9-8 | 4x5 | 7+4

6x4

8-5 [9+8 | 2x3 | 8+6 |16-7

7x3 | 8+6 | 11-9| 3x3 |14+9| 24-5

3+4 (11x2| 9-4 | 5x3 | 9+9

Type the question in the cells as follows:

I11 type 2X2
M11 type 4X5
Q11 type 9+8
I13 type 7X3
M13 type 14+9
Q13 type 11x2

Ji1
N11
R11
J13
N13
R13

type 20-4
type 7+4
type 2x3
type 8+5
type 24-5
type 9-4

K11 typeb+7
O11 type 6X4
S11 type8+6

K13 type 9-7
013 type 2x5
S13 type 5x3

L11type9-8
P11 type8-5
T11 type15-7
L13 type 3x3
P13 type3+4
T13 type9+9

Select the space of cells I11:T14, then format cell to Size 12, Bold
and click All Borders
Select the space of cells I12:T12 and cells T14:T14, then change
the font to Size 18.
Click menu Format >> Cells>> Alignment. Align the text in Center
both in Horizontal and Vertical directions, then click OK.
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10.

11.

Change the cell color as follows:

Cells I11:T11 change to Light Yellow

Cells T12:T12 change to Yellow

Cells T13:T13 change to Light Green

Cells I14:T14 change to Lime

Select the space of cells €9:F14, change the cell color to Black
(the picture of angel is hidden under 24 black boxes).

Click menu Format >> Cells>> Border,

select White Dot Click Inside Border

Merge cells I1:Q7 , type “Long time ago, there was an angel
breaking the heaven's rules. She, therefore, was cursed to stay
in the magic picture frame until there was someone good at
mathematics can decode and open the puzzle picture. The angel
shall appear. We hope you can help the angel”.

Set the font cell I1 to Size 11 and change the color to Dark Blue.
Click menu Format >> Cells >> Alignment, align the Horizontal text
to left(Indent) and Vertical text to Center and put ¥/Wraptext Click OK.
Merge cells I8:P8, type "The Mission to help Angel”

Format the cell I8 to size 16, Bold and change the cell color to Rose.
Click menu Format >> Cells >> Alignment, then align the text to
Center both Horizontal and Vertical directions. Click OK

Merge cells I9:Q10, type "1. You have to fill the answers in 24
blank boxes. 2. If your answer is correct, the box having the
same number as the answer shall be opened i.e. if the correct
answer is "2”, the second box shall be opened, if your answer is
not correct, the box could not be opened.
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12.

13.

14.

Set the font size in cell I9 to Size 11 and the font color to Violet.
Click menu Format >> Cells >> Alignment, align the Horizontal text to
left(Indent) and Vertical text to Top and put “/Wraptext Click OK.
Merge cells R8:T10 for placing the Picture.

Click menu Insert>> Picture> From Files.. > select the picture
from CD-Rom, click OK, then adjust the size of the picture and place
it in the indicated position.

Type the correct answer in the following cells:

Cell IT12 type 4 Cell J12 type 16 Cell K12 type 12
Cell L12 type 1 Cell M12 type 20 Cell N12 type 11
Cell 012 type 24 Cell P12 type3 Cell Q12 type 17
Cell R12 type 6 Cell 512 type 14 Cell T12 type 8
Cell IT14 type 21 Cell J14 type 13 Cell K14 type 2
Cell L14 type 9 Cell M14 type 23  Cell N14 type 19
Cell 014 type 10 Cell P14 type 7 Cell Q14 type 22
Cell R14 type 5 Cell S14 type 15 Cell T14 type 18

Type Formulas to link the answer and position in the picture

as follows:

Cell €9 type=L12 (number 1 will appear in the cell)

It means that any data contained in cell L12 will show up.

d.e. The data in CellL12 is number 1. When we delete the data in

L12, number O will show up in €9 instead).

Note : Select the space of cells C9:F14 and change the font color
to White fo see the number more clearly.
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Cell D9, type =K14 (No. "2" will show up)
Cell E9, type =P12 (No. "3" will show up)
Cell F9, type =I12 (No. "4" will show up)
Cell €10, type =R14 (No. "5" will show up)
Cell D10, type =R12 (No. "6" will show up)
Cell E10, type =P14 (No. "7" will show up)
Cell F10, type =T12 (No. "8" will show up)
Cell C11, type =L14 (No. "9" will show up)
Cell D11, type =014 (No. "10" will show up)
Cell E11, type =N12 (No. "11" will show up)
Cell F11, type =K12 (No. "12" will show up)
Cell €12, type =J14 (No. "13" will show up)
Cell D12, type =512 (No. “14" will show up)
Cell E12, type =514 (No. "15" will show up )
Cell F12, type =J12 (No. "16" will show up)
Cell €13, type =Q12 (No."17" will show up)
Cell D13, type =T14 (No. "18" will show up)
Cell E13, type =N14 (No. "19" will show up)
Cell F13, type =M12 (No. "20" will show up)
Cell C14, type =I14 (No. "21" will show up)
Cell D14, type =Q14 (No. "22" will show up)
Cell E14, type =M14 (No. "23" will show up)
Cell F14, type =012 (No. "24" will show up)
15. Click cell €9, select menu Format>> Conditional Formatting..
when the Conditional Formatting window appears, set up as according
to the picture as shown.

=TS v | equalto > |1
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It means that if the cell value is equal to 1, the condition is true.
Click

In the Format Cells window

Click Border , select None click OK.

Click Pattern , select None | No Color | click OK.
The outcome will be displayed as in the picture, click OK.

Condition 1
EEREMEEN ~ | |equal to |1
peEiore paBhCo1yZ2

| add>> || Delete.. | [ ok || cancal |

Try to type any numbers in cell €9. It can be seen that if the cell

value is not equal to 1, the cell color is still black covering the

picture of the angel. But if the cell value is equal to 1, the picture

of the angel will be displayed.

Set Conditional Formatting for all Black cells comprising cells

having the Number 2-24 by following the same procedure in item 15

(the cell value is equal to the number shown in each cells).

Hide the cell number by change the font in cell C9:F14 to Size 1 and

change the font color to Black.

Merge cells R1:T6 for placing the Hyperlink Picture.

Click menu Insert>> Picture>> From File.. >»> select the pictures, click OK.

Adjust the size of the picture and place it in the indicated position.
140



19.

20.

21.
22.

23.

Merge cells R7:T7 type "Play Game” Set the font to Size 10 ,

Bold and Green.

Create the Solution to Cursed Angel Game worksheet.
Change the name of Sheetl to SolutionAngel.

Right click on the SolutionAngel , select Moveor Copy...
select Vligeateaconyt click OK.

When the SolutionAngel (2) appears,

change the name to PlayGameAngel.

In the PlayGameAngel change “Play Game"” to"Solution”.
Create the link between Playing page and Solution page.
In the SolutionAngel , click the picture in cell R1,

then click Insert Hyperlink &

When the Insert Hyperlink window appears,

select Place in this Document.

For Cell Reference, select PlayGameAngel, click OK.

_ 4 - Cell Reference
+] PlayGamengel
Place in This —
Document SolutionAngel
Defined Mames

In the PlayéameAngel , click the picture in cell R1,
then click Insert Hyperlink =

When the Insert Hyperlink window appears,

select Place in this Document.

For Cell Reference, select SolutionAngel, click OK.

= 4 - Cell Reference
H FlayGameangel
Place in This d
Document I:l
Defined Mames
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24.

25.

26.

27.

28.

29.

Check the link between the 2 sheets to ensure that it can be moved
forward and backward between PlayGameAngel and SolutionAngel.
In the PlayGameAngel , delete the number in cells I12:T12 and
I14:T14, then you will see the black cell displayed in the Angel frame.
Unlock cell to be used as answering space, only in the PlayGameAngel
by click cells I12:T12, press Ctrl, then click to select cellsI14:T14.
Click menu Format>>Cells>>Protection> >,

click [¥llocked lock to [ILecked | then click OK.

Create Worksheet Protection

Click menu Tools> >Protection>>Protect sheet,

The window for defining Password shall appear to let you define your
password (you can either define or reject to use Password)

Note : To define Password, you have to remember your password
otherwise you will not be able to edit your sheet again.

Click uncheck ¥ select locked cells to become [ select locked cells
as shown in the picture:

Allow all users of this worksheet to: Allow all users of this worksheet to:
| select unlocked cells | select unlocked cells
Click OK.

It can be seen that all cells are locked except cells I12:T12 and
I14:T14 which can fill in the number.

In the SolutionAngel worksheet, you have to lock all worksheets by
following the procedure in item 27. It can be seen that all the cells
are locked for seeing solution only.

For Editing, Click menu Tools >> Protection >> Unprotect sheet...
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30.

31.

To Cancel the details of Program window elements,

click Tools > Options... >> View,

click to cancel the details which you would like to delete in both 2
sheets such as

Formula bar Status bar Gridiines Row & column headers Sheet tabs

Click OK

Note : In this game, you could not delete the head row and head
column otherwise the position of picture cell will not be in
the former position.

To save Cursed Angel Game

Click the Play6ameAngel sheet.

Click menu File >> Save as...» type the name Cursed Angel.

Click Save.
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